
Thank you very much for purchasing the product.

• To ensure correct and safe usage with a full understanding of this product's performance,
please be sure to read through this manual completely and store it in a safe location.

• Unauthorized copying or transferral, in whole or in part, of this manual is prohibited.

• The contents of this operation manual and the specifications of this product are subject to
change without notice.

• The operation manual and the product have been prepared and tested as much as possible.
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• Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage
which may occur through use of this product, regardless of any failure to perform on the
part of this product.

• Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage
which may occur with respect to any article made using this product.
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Introduction

This document describes operation when performing cutting using the included software.
To use the software, the command selection must be set to RML-1 when the main unit is switched on. For information on how to select
commands, see "User's Manual 1 -- Setup and Maintenance."

Setting the Command Set to RML-1
This chooses the instruction set immediately after switching on the power. When an instruction set has been chosen, it cannot be changed
until the power is reset.

 >1 SPEED SETTING
  2 SPINDLE RPM

*X      0  Y      0
 Z      0   5000 RPM

Hit "ENTER" >RML-1
Select MODE  NC-CODE

Switch on the power.
After the opening message, the screen for selecting the
instruction set appears.

1

Turn the dial to move the arrow to [RML-1], then press
the [ENTER] key.2

Choosing the Spindle Type
This sets the type of the installed spindle.
If a high-torque spindle is installed, choose [HIGH TORQUE]. If a high-speed spindle is installed, choose [HIGH SPEED]. An incorrect
selection may result in insufficient power to the motor and make normal cutting impossible, or conversely may apply power beyond the
rated capacity to the motor and cause an error to be displayed during cutting.

If the display shows coordinates, press the [ENTER] key
to display the main menu.1
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>10 OTHERS
 11 To Coordinate

10>2 SPINDLE UNIT
   3 BUZZER

10-2 SPINDLE UNIT
       <HIGH TORQUE>

Turn the dial to move the arrow to [OTHERS], then press
the [ENTER] key.2

Turn the dial to move the arrow to [SPINDLE UNIT],
then press the [ENTER] key.3

Turn the dial to move the arrow to [HIGH TORQUE] or
[HIGH SPEED], then press the [ENTER] key.
The selected mode is enclosed in angle brackets.

4

* To go back to the main menu, press the [EXIT] key
several times.

or
[HIGH SPEED]
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Part 11  Installing the Software

The Roland Software Package CD-ROM contains many different kinds of software.
You can view the software that can be used with this machine by displaying the setup menu on the CD-ROM and choosing the model
name.
See below for overviews and brief description of usage for the software displayed on the setup menu.

1-1 Software That Can Be Used

Software Overview

Windows driver This is necessary when sending data from a Windows-based program.
If you’re using Windows, be sure to install this driver.

MODELA Player ver. 3, MODELA 3D DESIGN, and MODELA 3D TEXT cannot be set
up separately.

MODELA programs

This sets the required parameters for cutting solid objects and sends the cutting data.
This can import not only solid objects created with three-dimensional programs from
Roland DG Corp., but also solid objects created using other commercially available three-
dimensional programs (via DXF or STL).

* MODELA Player ver. 3 does not support ATC units.

MODELA Player ver. 3

This lets you choose a basic shape such as a cylinder or sphere, and modify it to create a
three-dimensional object.
You can intuitively create solid objects with smooth curves.
You can cut solid objects and save data in three-dimensional DXF files.

MODELA 3D DESIGN

This adds thickness to text to create three-dimensional characters.
It’s also possible to edit text to make it bold, italic, or the like. You can put a box around
text with just a single click — a handy feature when making nameplates.
You can cut three-dimensional text and save data in three-dimensional DXF files.

MODELA 3D TEXT

This simulates tool movement before performing cutting.
You can use it to check the finished shape as well as things like whether the cutting depth
is suitable and how much time cutting will take. This can reduce loss for cutting materials
and time.

Virtual MODELA

This is used to design plates and send the engraving data.
You can make large numbers of plates with the same design with high efficiency. You can
use the TrueType fonts registered in Windows as the font style for text. You can even
make stroke fonts from TrueType fonts.
Because you can the outline of an image and convert it to line segments, it’s also possible
to include logos for companies or organizations in the plates you make.

Dr.Engrave

This adds thickness to a flat (two-dimensional) graphic to create a relief (raised engrav-
ing).
You can also add thickness to images such as illustrations.

3D Engrave
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1-2 Installing the Software

Setup

Switch on the computer and start Windows. If you are
installing under Windows NT 4.0/2000/XP, log on to
Windows as a member of the "Administrators" or "Power
Users" group.

1

Place the CD from the Roland Software Package in the
CD-ROM drive.
The Setup menu appears automatically.

2

When the screen shown below appears, click the  in
[Click here], then choose [MDX-650] or [MDX-500].
Click [Install].

To view the description of a program, click the  button.

To view the manual, click the  button.
(There are manuals in PDF format for the programs that

the  button references. Acrobat Reader is required to
view PDF files.)

If there are programs you don't want to install, then clear
their check boxes before you click [Install].

3

System Requirements

When installing, select the model name as follows.

 MDX-650A/650: [MDX-650]
 MDX-500: [MDX-500]

Select [MDX-650] even if you're using the MDX-650A.

Operating system

Computer

Drive

Monitor

Memory (RAM)

Free hard-disk space
required for installation

Interface

Windows 95/98/Me/NT4.0/2000/XP

Computer running Windows (Pentium processor or better recommended)

CD-ROM drive

Windows-compatible monitor capable of displaying 256 colors or more

32 MB or more recommended

32 MB

Printer port or COM port
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When all installation finishes, the screen at right appears.
Click [Close].7

After returning to the menu screen for installation, click

 .8

Remove the CD-ROM from the CD-ROM drive.9

The Setup program starts.  Follow the messages to carry
out setup and finish setting up the program.4

   * When the setup for one program finishes, the setup
for the next program starts.
In the interval until the next setup starts, a dialog box
showing the progress of processing is displayed.

If the following screen appears while installing the driver,
click the drop-down arrow and choose the port for the
cable connected to the computer.

When using an RS-232C (serial) cable
[COM1:] or [COM2:]
When using a printer (parallel) cable
[LPT1:] or [LPT2:]

5

The driver settings appear.
When you make the settings for the communication
parameters of the machine, make the parameters match
the values displayed here.
Click [Close] to finish installing the driver.  The driver
settings appear.

6



8

Part 1  Installing the Software

Application Settings
When you finish installing the applications, continue by making the following settings.  Be sure to make the settings before use.

MODELA Player ver. 3

Click [Start].
Point to [MODELA App Group] and click [mdx3p].1

From the [Options] menu, click [Machines...].
The [Model Selection] dialog box appears.2

Click [MDX-650 (RML-1)] or [MDX-500 (RML-1)],
then click [OK].3

From the [File] menu, click [Print Setup...].
The [Print Setup] dialog box appears.4
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Click the drop-down arrow for the name and click [MDX-
650 (RML-1)] or [MDX-500 (RML-1)].
Then click [OK].

5

Dr.Engrave

Click [Start].
Point to [Roland Dr.Engrave] and click [Dr.Engrave].1

From the [File] menu, click [Print Setup...].
The [Print Setup] dialog box appears.2

Click the drop-down arrow for the name and click [MDX-
650 (RML-1)] or [MDX-500 (RML-1)].
Then click [OK].

3
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3D Engrave

Click [Start].
Point to [Roland 3D Engrave] and click [3D Engrave].1

From the [Cut] menu, click [Machines...].
The [Model Selection] dialog box appears.2

Click the drop-down arrow for the name and click [MDX-
650 (RML-1)] or [MDX-500 (RML-1)].
Then click [OK].

5

Click [MDX-650 (RML-1)] or [MDX-500 (RML-1)],
then click [OK].3

From the [File] menu, click [Output Device Setup].
The [Print Setup] dialog box appears.4
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1-3 How to Use Help

If you have trouble using the program or driver, see the help screens. Help contains information such as descriptions of software opera-
tion, explanations of commands, and tips for using the software more effectively.

From the [Help] menu, click [Contents].1

Clicking on text that is green and underlined (by a solid
or dotted line) displays an explanation.2

Clicking on an image area that contains an explanation
displays the explanation.3

Tip:

   - When the pointer moves over green underlined text, it changes to a pointing hand (  ).

   - When the pointer moves over a location where an explanation is included, it changes to a pointing hand (  ).
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When there's a [?] button on screen
Clicking [?] in the upper-right corner of the window makes the

mouse pointer change to a question mark (  ).  You can then
move the  pointer over any item you wish to learn more about,
then click on the item to display an explanation of it.

When there's a [Help] button on
screen
Clicking [Help] lets you view help for the window or software.
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1-4 Overview of the Usage Guide

The included Roland Software Package CD-ROM contains the following PDF file.

- Cutting Tips
This describes tips and tricks for double-sided cutting and methods for securing the workpiece in place.

Location of the Usage Guides
The usage guide is found at the following locations.
View the following file directly from the CD-ROM, or copy the following file to your hard disk and read them from there.

- Cutting Tips
[Document] - [Cuttips] - [Cuttip-e.pdf]

Installing the Acrobat Reader
Acrobat Reader is required to view PDF files.
If Acrobat Reader is not set up on your computer, you need to set it up.
The included CD-ROM also contains Acrobat Reader.

[Acrobat] - [English] - [ar405eng.exe]
(This runs under Windows 95 or later.)
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Part 22  Basic Operation

2-1 Making Settings Using the Liquid-crystal Display

 8-3 PARITY BIT
              <EVEN>

 8-3 PARITY BIT
              <NONE>

 8>1 STOP BIT
   2 DATA BIT

Pressing the [ENTER] key 
at this time displays the menu.

Press the 
[ENTER] key.

Turn the dial to 
change the setting.

Turn the dial to move the 
arrow (    ) to the item whose 
setting you want to make.

Press the 
[ENTER] key.

Angle brackets (< >) are displayed.

Press the [EXIT] key to 
return to the previous screen.

You can move the tool or change the spindle speed by turning the 
dial while coordinate values are displayed.
To move the tool, use the [JOG] key to choose an axis (either [X], 
[Y], or [Z]), then turn the dial. To change the spindle speed, choose 
[??00 RPM], then turn the dial.
At this time, a [*] (asterisk) appears next to the chosen item.

The value (or selection choice) 
enclosed in angled brackets 
(< >) indicates the current setting.

Press the [EXIT] key to 
return to the previous screen.

*X      0  Y      0
 Z      0   5000 RPM

Main Menu

 >8 SERIAL PARAMETER
  9 COMPENSATE

 >1 SPEED SETTING
  2 SPINDLE RPM

 8>3 PARITY BIT
   4 BAUD RATE

 8-3 PARITY BIT
               EVEN

Press the 
[ENTER] key.

Turn the dial to move the 
arrow (    ) to the item whose 
setting you want to make.
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2-2 Setting the Connection Parameters

Connection with a parallel cable is called a "parallel connection," and connection with a serial cable is called a "serial connection."  Make
the appropriate settings on both the computer and the main unit to configure the equipment for the type of connection that has been made.
To make the settings on the computer, refer to the manual for the computer or the software in use.

Press the [EXIT] key to display the main menu.1

Turn the dial to move the arrow to [CONNECTION],
then press the [ENTER] key.2

Turn the dial to choose [AUTO], then press the [ENTER]
key.3

 >7 CONNECTION
  8 SERIAL PARAMETER

 7 CONNECTION
              <AUTO>

Press the [EXIT] key once to return to the screen at right.4

Turn the dial to move the arrow to [SERIAL PARAM-
ETER], then press the [ENTER] key.5

Turn the dial to move the arrow to the item you want,
then press the [ENTER] key.6

Turn the dial to choose a value (or selection), then press
the [ENTER] key.7

 >7 CONNECTION
  8 SERIAL PARAMETER

 >8 SERIAL PARAMETER
  9 COMPENSATE

 8>1 STOP BIT
   2 DATA BIT

 8-1 STOP BIT
                 <1>

For serial
connection

only
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2-3 Cutting Condition Setting

Before you begin the actual cutting process, the cutting conditions such as the revolution speed of the spindle motor and the feeding
speed of each axis must be designated according to the quality of the workpiece and the type of tool used.  There are several deciding
factors to be taken into account when designating the cutting conditions.

The quality of the workpiece The type of tool used The diameter of the tool used
The cutting method The cutting shape

Designate the cutting conditions in consideration of the above factors by performing the following three setting operations.

1. The spindle motor revolution speed (tool revolution speed)
2. The feeding speed (tool moving speed)
3. The cutting-in amount (depth of one cutting operation)

Note : You can set the cutting conditions using either the program or the machine, but in most cases the program settings take
priority.

In this manual, these three conditions are called the cutting conditions.  The characteristics and points to consider for each of these
conditions are as follows.

Characteristics/Points to ConsiderItem

The bigger this number, the faster the cutting speed.  However, if this number is too large, the
work surface may melt or burn due to excessive friction.  Conversely, if this number is made
smaller, the time taken for cutting becomes too longer.  Generally speaking, the entire cutting
speed is determined by the cutting edge speed, so the smaller the tool diameter, the higher the
spindle revolution speed required.  (When performing engraving without rotating the cutting
tool, set [SPINDLE CONTROL] to [OFF.])

Revolution speed
When [SPINDLE UNIT] is set to [HIGH SPEED] :  5000 to 20000 rpm
When [SPINDLE UNIT] is set to [HIGH TORQUE] :  3000 to 12000 rpm

Spindle motor revolution
speed

When the feeding speed is high, processing becomes rough and flash marks tend to remain on
the cut surface.  On the other hand, when the feeding speed is slow, processing takes more
time.  Be careful because a slower feeding speed does not always result in improved finishing.

Feeding speed

When the cutting-in amount is deeper, the cutting speed increases, but the cutting-in amount is
limited by the quality of the workpiece.  In cases where the required depth can not be cut at
once, repeat cutting several times to depth that does not breach the limit.

Cutting-in amount
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Setting the Cutting Conditions
This section describes how to set the cutting conditions using the display on the main unit.

   * If the cutting conditions can be set with your current software, this is a faster and more efficient method than manual
setting.  It makes no difference when you come to construct a program.

Speed

Press the [EXIT] key to display the main menu.1

Turn the dial to move the arrow to [SPEED SETTING],
then press the [ENTER] key.2

Turn the dial to move the arrow to the item you want,
then press the [ENTER] key.

   * Set the feed speed during cutting with [XY CUT
SPEED] and [Z DOWN SPEED], and set the
movement speed when the tool is raised with [XY
MOVE SPEED] and [Z UP SPEED].

3

Turn the dial to change the value, then press the [ENTER]
key.4

 >1 SPEED SETTING
  2 SPINDLE RPM

 1>1 X/Y CUT SPEED
   2 Z DOWN SPEED

 1-1 X/Y CUT SPEED
          <  2 mm/s>
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Spindle Motor Revolution Speed

Making the Setting Using the Display Menu

Cutting-in Amount
The cutting-in amount is set by setting Z1.  For more information on the Z1 setting, see "2-5  Setting the Z1 and Z2 Position."

Press the [EXIT] key to display the main menu.1

Turn the dial to move the arrow to [SPINDLE RPM],
then press the [ENTER] key.2

Turn the dial to change the value, then press the [ENTER]
key.

   * The set speed is stored in memory even after you
switch off the power, and remains in effect until you
make a new setting.

3

RPM : Revolutions Per Minute

 >2 SPINDLE RPM
  3 MECHA MOVING

  2 SPINDLE RPM
         < 5000 RPM>

Making the Setting When Coordinate Values Are Displayed

Press the [EXIT] key to display the coordinate-view
screen.1

Press the [JOG] key to move the [*] to [??00 RPM].2

Turn the dial to change the speed.

   * When you switch off the power, the set speed is lost
and reverts to the setting for [SPINDLE RPM].

3

*X      0  Y      0
 Z      0   5000 RPM

 X      0  Y      0
 Z      0 * 5000 RPM

 X      0  Y      0
 Z      0 * 5000 RPM

RPM : Revolutions Per Minute
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Cutting Condition Setting Examples
The chart below contains reference examples of the appropriate cutting conditions for several types of workpiece material.  In the case
that the conditions are input using software or when constructing your own programs, set the cutting conditions with reference to the
chart.  However, because conditions differ depending on tool sharpness and workpiece hardness, cutting performance may not always be
optimal when adhering to the conditions specified below.  In such a case, delicate adjustment should be performed at the time of actual
cutting.

Tool

ZUS-600

ZEC-H4032

ZHS-H4400

ZUS-600

ZEC-H4032

ZHS-H4400

ZUS-600

ZEC-H4032

ZHS-H4400

ZUS-600

ZUS-600

ZEC-H4032

ZHS-H4400

ZDC-D2000

ZUS-600

ZEC-H4032

ZHS-H4400

ZDC-D2000

ZUS-600

ZUS-300

Spindle revolution

speed [RPM]

8000

10000

10000

8000

10000

10000

8000

10000

10000

8000

8000

12000

Without rotation

Without rotation

8000

12000

Without rotation

Without rotation

12000

12000

Cutting-in amount

[mm]

2

0.5

0.8

2

0.4

0.5

0.37

0.2

0.2

0.37

0.2

0.05

0.1

0.1

0.2

0.05

0.1

0.1

3

2

Workpiece

Modeling wax (option)

Chemical wood

Acrylic resin

ABS plastic

Aluminum

Brass

Sanmodur SS (option)

XY axis feeding

[mm/sec.]

18

30

30

20

30

30

16

15

15

24

14

5

10

10

14

5

10

10

40

40

Z axis feeding

[mm/sec.]

18

10

5

20

10

5

16

5

5

24

3

1

1

1

3

1

1

1

30

30
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2-4 Setting the Origin Points (XY Origin Point and Z0)

Make the settings for the XY origin (the origin point for the X and Y axes) and Z0 (the Z-axis origin point).

About the XY Origin Point
You can choose from among three types according to the target and usage.
These are broadly divided into points are set where you want (USER) and points that are set as mechanical fixed points (LIMIT and
CENTER). For the latter, you can also choose either the front left or the center.
This section describes the selections. For information about how to make the selections, see "Choosing the XY Origin" in the following
section.

USER
This sets the origin point where you want.
Choose this when setting the origin point to match the position
where the workpiece is loaded. The setting is normally made at the
front-left corner of the workpiece.

Y

X

LIMIT
This is a mechanical fixed point, and is set at the front-left corner
of the maximum cutting range.

Y

X

Table

Workpiece

Maximum cutting range

XY Origin Point ([USER])

Table

Maximum cutting range

CENTER
This is a mechanical fixed point, and is set at the center of the
maximum cutting range.
However, you can offset the center point in order to use a center
vise. For more information, see "Offsetting the Center point."

XY Origin Point
([LIMIT])

Y
X

Table

Maximum cutting range

XY Origin Point
([CENTER])
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Setting the XY Origin Point

Choosing the XY Origin Point

Turn the dial to move the arrow to the item you want,
then press the [ENTER] key.
If you chose [USER], then continue with the procedure in
"Setting the Origin Where You Want."
To choose [CENTER] and offset the center point aligned
with the center of the center vise, see "Offsetting the
Center Location."

3

Turn the dial to move the arrow to [ORIGIN CHANGE],
then press the [ENTER] key.2

Press the [EXIT] key to display the main menu.1

 >4 ORIGIN CHANGE
  5 MOVING MODE

  4 ORIGIN  CHANGE
              <USER>

Setting the Origin Where You Want
If you chose [USER] with [ORIGIN CHANGE], then set the origin point where you want on the loaded workpiece.
The following section describes how to set the origin point. This section assumes that the XY origin point is set at the front-left corner of
the workpiece.

Press the arrow keys and the TOOL UP/DOWN keys to
move the cutting tool to a position close to the front left
corner of the workpiece.

2

Press the [EXIT] key to display the coordinate-view
screen.1 *X      0  Y      0

 Z      0   5000 RPM

Press the [JOG] key to move the [*] on the screen to [X]
or [Y].3
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Turn the dial to move the tool a little at a time.4

Repeat steps 3 and 4 to align the center of the tool with
the front-left corner of the workpiece.5

Press the [XY/A] key (If you're using MDX-500, press
[XY] key) to display the screen at right.6

Press the [ENTER] key.
The screen flashes once, then returns to the coordinate
view.

7

Set User Origin
Hit "ENTER" key
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Use the arrow keys and the TOOL UP/DOWN keys to
move the tool to a position near the upper surface of the
center vise.

   * Here, if the tip of the tool is exactly at the center of
the center vise, you don't need to make the following
settings. The center of the cutting area matches the
center position of the center vise.

5

Offsetting the Center Location
When the [ORIGIN CHANGE] selection is [CENTER], the origin point is set at the center of the workpiece mounted in the center vise.

 >3 MECHA MOVING
  4 ORIGIN CHANGE

Turn the dial to move the arrow to [MECHA MOVING],
then press the [ENTER] key.1

 3 >8 Go CENTER Pos.
    9 Go LIMIT Pos.

Turn the dial to move the arrow to [Go CENTER Pos.],
then press the [ENTER] key.
Move the tool to the center of the cutting area.

2

While no material is attached, tighten the center vise
completely.3

Press the [EXIT] key to display the coordinate-view
screen.4 *X      0  Y      0

 Z      0   5000 RPM

   * The finely adjusted center position is stores in memory even
after you switch off the power.

Press the [XY/A] key (If you're using MDX-500, press
[XY] key) to display the screen at right.7

Press the [ENTER] key.
The screen flashes once, then returns to the coordinate
view.

8

Set Center Position
Hit "ENTER" key

Use the dial to align the tip of the tool with the center of
the center vise.6

*X      0  Y      0
 Z      0   5000 RPM
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Workpieace

Setting the Z0 Position
The Z0 position is the point that becomes the origin point in the Z directions.  Usually, this point is set at the surface of the fixed
workpiece.  (The following explains the method for setting the workpiece surface Z0 position.)

Press the [EXIT] key to display the coordinate-view
screen.1

Press the arrow keys and the tool up/down keys to move
the cutting tool close to the surface of the workpiece.2

*X      0  Y      0
 Z      0   5000 RPM

Turn the dial to align the tip of the cutting tool with
surface of the workpiece.3

Press the [Z] key.4

Turn the dial to move the arrow to [Set Z0 Pos. HERE],
then press the [ENTER] key.
The screen flashes once, then returns to the coordinate
view.

5 >1 Set Z0 Pos. HERE
 2 Set Z1 Pos. HERE

   * The set value is stored in memory even after you switch off
the power.

The following method can be used to set the Z0 position even more precisely.  This method is suitable for cases
where the position is marked with an oil pen and later cut off.
Set Z0 as the position where the ink was cut off.

First, make a mark on the work
surface with a generally
available oil pen, etc.

Press the [SPINDLE] key to make the
spindle rotate.  Place the tool in the
marked position, then lower the tool until
the ink is cut off. The ink mark on the
work surface has a certain thickness, so
only the ink is removed.
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Setting Z0 with the Z0 Position Sensor (Included with the
Unit)
The Z0 sensor included with the unit is used to set the Z0 point on
the surface of the workpiece.  The Z0 sensor is placed on the
location which is to serve as the Z0 point, and the Z0 point is set.

Install the Z0 position sensor.1

Place the Z0 position sensor on top of the workpiece.2

Use the arrow keys and the tool up/down keys to move to
a position 2 to 3 mm (0.079 in. to 0.118 in.) above surface
of the Z0 sensor.

3

Z0 Position Sensor
Z0

Press the [EXIT] key to display the main menu.4

Turn the dial to move the arrow to [OTHERS], then press
the [ENTER] key.5 >10 OTHERS

 11 SELF MODE

Do not connect the Z0 sensor to the EXT2
connector. Doing so may damage the
sensor.

NOTICE
Z0 position sensor

Z0 position sensor jack
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Turn the dial to move the arrow to [SENSOR MODE],
then press the [ENTER] key.

If the Z0 sensor is not installed, the display shows the
screen at right for several seconds, then returns to the
previous screen.

Install the Z0 sensor, make sure the arrow is at [SENSOR
MODE], then press the [ENTER] key.

6 10>1 SENSOR MODE
   2 SPINDLE UNIT

10>1 SENSOR MODE
   2 SPINDLE UNIT

10-1 SENSOR MODE
   Z0 SENSOR NOTHING

10-1 SENSOR MODE
 Please Cursor Move

Use the tool up/down keys and the dial to move the
cutting tool until its tip comes into contact with the Z0
position sensor.

7

*X      0  Y      0
 Z      0  [SENSOR]

10>1 SENSOR MODE    
      SET Z ORIGIN!

Press the TOOL DOWN key or turn the dial to display the
screen at right.

When the tool comes into contact with the Z0 sensor,
movement stops and the screen at right appears.

The tool rises and the display returns to the previous
screen.

Remove the Z0 position sensor.8

   * The set value is stored in memory even after you switch off
the power.

The Z0 sensor removed from above the workpiece must be placed outside the cutting range. Otherwise the cable may
become caught during operation of the XY table, damaging the sensor.
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2-5 Setting the Z1 and  Z2 Position

The cutting tool up position (Z2 point) and down position (Z1
point) are normally set with the software.  If they cannot be set
with your current software then set them manually using the keys
on the switch panel.

Workpiece
Z0

Z2
Tool up position

Tool down position

Tool

Z1

Z axis 
origin point

Press the [EXIT] key to display the coordinate-view
screen.1

Press the arrow keys and the tool up/down keys to move
the cutting tool close to the point where Z1 will be set.
When setting Z1, move the cutting tool to a position away
from the loaded workpiece.

2

*X      0  Y      0
 Z      0   5000 RPM

Turn the dial to gradually move the cutting tool to the
height where the Z1 point is to be set.3

Press the [Z] key.4

Turn the dial to move the arrow to [Set Z1 Pos.HERE] for
Z1 or to [Set Z2 Pos.HERE] for Z2. Then press the
[ENTER] key.
The screen flashes once, then returns to the coordinate
view.

5

   * The set value is stored in memory even after you switch off
the power.

Z1

>2 Set Z1 Pos. HERE
 3 Set Z2 Pos. HERE

Z2

>3 Set Z2 Pos. HERE
             -<END>-
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2-6 Downloading Cutting Data

Do not insert the fingers between
the XY table and base or between
the head and Z cover.
Doing so may result in injury.

Do not insert the fingers between
the T-slot table and arms or between
the head and Z cover.
The fingers may be pinched, resulting in
injury.

Head

Z cover
T-slot table

Arm

Do not wear gloves, a necktie or
wide-sleeved clothing.
They may become
caught in the tool,
resulting in injury.

Do not operate beyond capacity or
subject the tool to undue force.
The tool may break or fly off in a random
direction. If cutting beyond capacity is
mistakenly started, immediately turn off the
switch.

 To keep cutting waste from being scattered, we recommend using a commercially available vacuum cleaner to take up
cutting waste during cutting. For information on attaching a vacuum cleaner, see "User's Manual 1 - Setup & Mainte-
nance."

Wear dust goggles and mask during
use.
Cutting dust may scatter, causing bodily
injury.

Use a commercially available brush
to remove metal cuttings.
Attempting to use a
vacuum cleaner to
take up metal
cuttings may cause
fire in the vacuum
cleaner.

Perform dry cutting with no cutting
oil.
Such materials can
cause fire.
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When performing cutting using three-dimensional data created with a commercial program (in DXF or STL format), output is from the
included MODELA Player ver. 3 program. This document describes some examples of cutting using MODELA Player ver. 3. Refer to
"Part 3  Software Guide - 3-2  Cutting Using MODELA Player ver. 3."
When performing output from the included Dr. Engrave program or a commercially available drawing program, use the included 2.5D
Driver (Windows only). For more information about the 2.5D Driver, see the help screens for the 2.5D Driver on the included CD-ROM
and "Part 3  Software Guide - 3-1  Windows Driver."
For information on how to use the included programs, take a look at "Part 3  Software Guide" and the help screens for each of the
programs.

When cutting starts, the screen at right appears.

    - You can change the spindle speed by turning the dial. Note that the changed spindle speed is in effect only during cutting.
    - Pressing the [EXIT] key displays the coordinate view screen only while the key is held down. (Displaying the coordinates while

cutting is in progress may lengthen the cutting time.)

LOAD Min[>>>>>>>]MAX
     20000RPM

Stopping the Cutting Process
If you want to change the shape to cut and redo cutting from the beginning, or if the data was different from what you wanted to cut, then
follow the steps below to stop operation.

PAUSE>CONTINUE
      STOP

PAUSE>STOP
      X/Y CUT SPEED

While operation is in progress, press the [PAUSE] key.
Movement of the tool and table stops. Note that because
this is not an emergency stop, movement may continue
for two or three seconds before stopping.
The screen at right appears.

1

Stop sending data from the computer2
Stop execution of the program.3
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Changing the Feed Rate or Spindle Speed During Cutting
The feed rate and spindle rotating speed set by the software can be changed while cutting is in progress.
This is done by first pausing the machine during cutting, then changing the feed rate or spindle rotating speed.  However, if the computer
subsequently sends a command to change the feed rate or spindle rotating speed, the setting will change as specified by the new
command.
The following method is appropriate for making delicate halfway adjustments to conditions previously set using software, etc.
For more information about the spindle-motor speed and the feed rate, refer to "2-3  Setting the Cutting Conditions."

While operation is in progress, press the [PAUSE] key.
Movement of the tool and table stops. Note that because
this is not an emergency stop, movement may continue
for two or three seconds before stopping.
The screen at right appears.

1

Turn the dial to move the arrow to the item you want,
then press the [ENTER] key.2

PAUSE>CONTINUE
      STOP

PAUSE>X/Y CUT SPEED
      Z DOWN SPEED

Turn the dial to change the value, then press the [ENTER]
key.
To change another item, press the [EXIT] key, then repeat
steps 2 and 3.

3 PAUSE:X/Y CUT SPEED
          <  2 mm/s>

Press the [EXIT] key to return to the screen at right.4

Turn the dial to move the arrow to [CONTINUE], then
press the [ENTER] key.
The paused state is canceled and cutting resumes.

5

PAUSE>CONTINUE
      STOP
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2-7 Finishing

Do not touch the tip of the blade
with your fingers.
Doing so may result in injury.

Do not touch the tool immediately
after cutting operating stops.
The tool may have become hot due to
friction heat and may cause burns if
touched.

Please use a vacuum cleaner to
remove cutting dust.
Do not use any blower like airbrush.
Otherwise, dust spread in the air may harm
your health.

After cutting has been finished, detach the tool, remove the material, and clean away chips.

Press the [EXIT] key to display the main menu.1

Turn the dial to move the arrow to [MECHA MOVING],
then press the [ENTER] key.2

Turn the dial to move the arrow to [Go LIMIT Pos.], then
press the [ENTER] key.3

Detach the tool.4

 >3 MECHA MOVING
  4 ORIGIN CHANGE

 3 >9 Go LIMIT Pos.
   10 To Main MENU

Use a commercially available brush
to remove metal cuttings.
Attempting to use a
vacuum cleaner to
take up metal
cuttings may cause
fire in the vacuum
cleaner.
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Remove the material.6

Turn the dial to move the arrow to [Go VIEW Pos.], then
press the [ENTER] key.5  3 >3 Go VIEW Pos.

    4 Go Z1 Pos.

Use a commercially available vacuum cleaner to take up
cutting waste.7
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Driver for Windows 95/98/Me
This sends data to the main unit from a Windows-based program.
When sending data from Dr. Engrave or a commercially available drawing program, the driver sets engraving parameters such as the
tool’s operating speed, depth, and pitch.
When sending data from MODELA Player ver. 3 or 3D Engrave, the data is sent to the driver’s output port. At this time, all driver
settings other than the port are ignored, and do not affect cutting.

Display the Driver Setting Screen
To make the settings for the driver, open Properties. You can use either of the two methods described below to open Properties.

Method 1
To save values you've changed with Properties, use this method to make the settings.

Part 33  Software Guide

3-1 Driver for Windows

This describes the general procedures for software.
For detailed descriptions, take a look at the help screens for the respective software.

Click [Start]. Point to [Settings] and click [Printer].
The [Printers] folder appears.1

Right-click on the MDX-650 or MDX-500 icon, then
click [Properties].2
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Method 2
If you opened Properties for the driver from a program, the values you set there are only temporary, and are not saved. To save the
Properties settings for the driver, use Method 1.

Click the [Size] tab.1

Enter the Cutting Area
Enter the size of the workpiece.

Enter values for [Width] and [Length].2

From the [File] menu, click [Print Setup...].
The [Print Setup] dialog box appears.2

Set the printer to [MDX-650 (RML-1)] or [MDX-500
(RML-1)], then click [Properties].3

Start the program and open a file.1
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Set the Engraving Parameters
You can assign different colors to the data and set the parameters for performing engraving of the corresponding data by color.

Click the [Tool] tab.1

Click the tab for the color to set.
The numeral appearing next to the color is the tool
number that is now set.

2

Click the drop-down arrow for [Tool], then click the tool
number.
If you don’t wish to engrave lines of that color, click
[None].

3

For [Z Down Position], enter the cutting-in depth.
Cutting to the depth of [Z Down Position], with each
cutting pass made at the depth set with [Z Engraving
Pitch].

4
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Driver for Windows NT 4.0/2000/XP
This sends data to the main unit from a Windows-based program.
When sending data from Dr. Engrave or a commercially available drawing program, the driver sets engraving parameters such as the
tool’s operating speed, depth, and pitch.
When sending data from MODELA Player ver. 3 or 3D Engrave, the data is sent to the driver’s output port. At this time, all driver
settings other than the port are ignored, and do not affect cutting.

To make the settings for a printer driver, log on to Windows as a member of the “Administrators” or “Power Users” group.

The description of the following procedures use screen shots from Windows 2000.

Display the Driver Setting Screen
To make the settings for the driver, open Properties. You can use either of the two methods described below to open Properties.

If the tool-down position (Z1) is set at a location lower
than the Z-axis cutting range, the screen at right appears
while cutting is in progress, and operation pauses.
When cutting material of uneven thickness using the depth regulator nose, set the tool-down position at a lower
height than the actual cutting depth (see "User's Manual 1 - Setup & Maintenance"). As a result, the tool-down
position (Z1) is set at a location lower than the Z-axis cutting range.
To clear the error message, switch off the power.
To avoid errors, place a flat board under the workpiece to serve as a lifting base.

Bad Parameter

For [Fill Pitch], enter the diameter of the tool tip.
To achieve an attractive finish, enter a value narrower
than the actual diameter.

5
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Method 1
To save values you've changed with Properties, use this method to make the settings.

Open the [Printers] folder. If you're using Windows XP,
go to Control Panel and open [Printers and Faxes].1

Set the printer to [MDX-650 (RML-1)] or [MDX-500
(RML-1)], then click [Properties].
If you're using Windows 2000/XP, the [Property] dialog
box displays. Click [Advanced].

3

If you're using Windows 2000/XP, right-click the MDX-
650 or MDX-500 icon, then click [Printing Preferences].
The [Printing Preferences] dialog box appears. Click
[Advanced].
If you're using Windows NT 4.0, right-click the icon, then
click [Document Defaults].

2

Method 2
If you opened Properties for the driver from a program, the values you set there are only temporary, and are not saved. To save the
Properties settings for the driver, use Method 1.

From the [File] menu, click [Print Setup...].
The [Print Setup] dialog box appears.2

Start the program and open a file.1
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Enter the Cutting Area
Enter the size of the workpiece.

Click the [Work Size Settings] document option.
For Windows 2000/XP, click [Properties]. For Windows
NT 4.0, click [Work Size Settings].
The [Work Size Setting] dialog box appears.

1

Click [Add New Work Size], then for [Work Size], enter
values for [Width] and [Length].2

Enter the [Work Size Name], then click [OK].
* For [Work Size Name], use only alphanumeric charac-

ters.
3
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Set the Engraving Parameters
Make the settings for the composition of the workpiece to engrave and the engraving depth.
Choosing the composition sets engraving parameters suited to this engraving. However, [Tool Down Position] and [Fill] - [Tool Width]
are determined with no relation to composition, and so they are set separately. For [Tool Down Position], enter the engraving depth. For
[Fill] - [Tool Width], enter the tool diameter.
The values for settings other than [Tool Down Position] and [Fill] - [Tool Width] are also suggested guidelines. If the results of actual
engraving are not as expected, modify the values accordingly.

Lines are distinguished by color, and parameters when engraving a line of the corresponding color are set.

Double-click [Color] to display the lower level.
Click the color to set, then click the tool number.
If you don’t wish to engrave lines of that color, click
[None].

2

Click any tool from 1 to 4 to display the lower level.
Click [Material], then click the composition of the
engraving material (workpiece).

1
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Double-click on the tool number to display the lower
level.
Click [Z Down Position] and enter the cutting-in depth.
Cutting to the depth of [Z Down Position], with each
cutting pass made at the depth set with [Z Engraving
Pitch].

3

For [Fill], click [Tool Width], then enter the diameter of
the tool tip.4

For items other than [Tool Down Position] and [Fill] - [Tool Width], suitable values are set for engraving the composi-
tion you chose in step 1.  However, these values are only suggestions. If the results of actual engraving are not as
expected, adjust the values accordingly.

If the tool-down position (Z1) is set at a location lower
than the Z-axis cutting range, the screen at right appears
while cutting is in progress, and operation pauses.
When cutting material of uneven thickness using the depth regulator nose, set the tool-down position at a lower
height than the actual cutting depth (see "User's Manual 1 - Setup & Maintenance"). As a result, the tool-down
position (Z1) is set at a location lower than the Z-axis cutting range .
To clear the error message, switch off the power.
To avoid errors, place a flat board under the workpiece to serve as a lifting base.

Bad Parameter
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MODELA 3D DESIGN
This lets you choose a basic shape such as a cylinder or sphere, and modify it to create a three-dimensional object.
You can intuitively create solid objects with smooth curves.

Choose the basic shape

Decide on the number of reference lines
The reference lines are control rods for arranging the shape of the object.
To determine the number of reference lines, click the controls shown below.

Click   .

The [Primitives] dialog box appears.

1

Click the basic shape that is closest to the finished form.
Enter the size, then click [OK].2

: 4 lines : 7 lines : 10 lines

3-2 Application Software
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Manipulate Reference Lines to Make a Shape

To change the height of a reference line, position the pointer over
the reference line and drag it up or down.

To change the size of the outer perimeter for a reference line,
position the pointer over the reference line and drag it to the left or
right.

To change the shape of the outer perimeter, right-click on a
reference line.
The [Select section] dialog box appears.
Make the settings to obtain the desired shape.

To change the center point of the outer perimeter, click  

and drag the reference line.
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Save the data

Click the   .

The [Save As] dialog box appears.
Enter the name of the file and click [Save].

Check the shape

Click the   .

The [Rendering] dialog box appears.

1

Drag the scroll box for the X, Y, or Z scroll bar.
The object rotates, letting you view it from various
perspectives. To color the object, click [Start].

2
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Description of Controls

This opens new file.

This opens an existing file.

This saves the file, overwriting the previous data.

This moves a reference lines up or down.

When    is selected, the location of the center

point moves up or down.

This moves a reference lines right and left.

When    is selected, the location of the center

point moves right and left.

When this is selected, dragging a reference line
changes the size of the outer perimeter.

When this is selected, dragging a reference line
moves the center point of the outer perimeter.

This saves the data as a DXF file.

This starts MODELA Player ver. 3.

This undoes the very last operation.

This zooms the screen in or out.

This displays the coordinates of the reference
lines.

This changes the point of view.

This adds color and shadowing to the object's
surfaces.

This determines the number of
reference lines.

This displays help for 3D DESIGN.
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Determine the Font and Size of the Text

Save the data

Click the   .
The [Save As] dialog box appears.
Enter the name of the file and click [Save].

MODELA 3D TEXT
This adds thickness to text to create three-dimensional characters.
You can use the TrueType fonts registered in Windows as the font style for text.

Enter the Text
Click the [Edit] text box, then type in the text.
Make sure what you’ve typed in is correct, then click [Go!].

Click the [Font] drop-down arrow, then click on a font
name.1

Click the [Scale] drop-down arrow, then click on a size.2

- You cannot specify a font size that is not listed.
- If you want to know the size of the entire text string that you typed in, click [Show Information].
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MODELA Player ver. 3
For information on how to use MODELA Player ver. 3, see “3-3 Cutting Using MODELA Player ver. 3.”

Description of Controls

This opens new file.

This opens an existing file.

This saves the file, overwriting the previous data.

This changes how the object is displayed.

This starts MODELA Player ver. 3.

This lets you choose the color of the object from
among ten available colors.

This slants the text in the height direction.

This changes the height of the text.

This inverts the background color.

This determines the roughness of curved
portions of the text.

This assigns the desired color to the object.

This displays dimensions around the object.

This saves the data as a DXF file.

This slants each individual character to the
left or right.

This puts a frame around the text.

This rotates each individual character 90 degrees
counterclockwise.

This makes the text italic.

This makes the text bold.
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Virtual MODELA
You can use a tool path created with MODELA Player ver. 3 or 3D Engrave to verify the cutting process and results on-screen before you
perform actual cutting.
You can start this program directly with commands from MODELA Player ver. 3 or 3D Engrave. For more information, see "3-2
Application Software   3D Engrave."

With Virtual MODELA, you can display the cutting process and results in a wide variety of ways.

Animating the Screen During Simulation

Click the , this button is on.  When it is off, only the shape after simulation is displayed.

Switching the Screen Between Flat and Three-dimensional Views During
Simulation

•  Clicking  switches from a flat view to a three-dimensional view.
When this button is selected, the view is three-dimensional during and after simulation.

• Clicking  switches from a three-dimensional view to a flat view.
When this button is selected, the display shows a view of the workpiece as seen from above during and after simulation.

Changing the Perspective at the Simulation Screen (Only During 3D View)

You can use the following buttons only when  has been clicked to display a 3D view.

• Clicking  rotates the object counter-clockwise around the Z axis, in steps of 90 degrees.

• Clicking  rotates the object clockwise around the Z axis, in steps of 90 degrees.

Checking the Shape After Simulation

You can use the following buttons only when  has been clicked.

Rotating

You can use the following buttons only when  has been
clicked.

Moving the Location

Click  , then drag on the screen.

Zooming in or out

Click  , then drag on the screen.

Zoom in
Drag toward the top of the screen.

Zoom out
Drag toward the  bottom of the screen.
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Description of Controls

This creates a new, uncut workpiece. This switches between adding and not adding
color to the surface of the workpiece.
To specify a color, click [Options] - [Surface
Color].

This opens an existing cutting-configuration file.

This saves the shape of the present workpiece in a
file.

This performs the cutting simulation over again,
using the presently imported tool path. Use this
when you want to check the movement of the tool
again.

This quits the simulation.

This starts cutting.
If cutting was previously interrupted, it resumes
cutting.

This displays a prediction of how much time
cutting will take. The time is a general estimate.
In addition to the time, you can also verify the tool
movement distance and movement range.

This displays the simulation screen as a flat (two-
dimensional) view.

This displays the simulation screen as a solid
(three-dimensional) view.

These change the perspective when
displaying a simulation three-dimension-
ally.

This is for checking the shape after cutting
simulation.

This displays the movement of the tool with
animation.

This restricts the 3D view range.
It also determines the printing area when perform-
ing 2D simulation.
Restricting the range makes 3D view faster than
when displaying the entire workpiece.

This pastes and image on the surface of the
workpiece.
By pasting an image of wood or metal, you can
make the workpiece look more realistic.
T o select the image to paste, click [Options] -
[Texture Setup].

This rotates the object, changing the perspective.
This is available only during 3D view.

This zooms the view of an object in or out.
This is available only during 3D view.

This changes an object's displayed location on the
screen.
This is available only during 3D view.

This enlarges or reduces what is displayed to fill
the drawing size.

This selects how the object is
displayed when on the 3D screen
when not performing any opera-
tion.

This selects the image to paste on the surface of
the workpiece.

This changes the direction and brightness of
incident light, thereby changing the shading.
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Dr. Engrave
This is used to design plates and send the engraving data.
You can make large numbers of plates with the same design (such as nameplates and rating plates) with high efficiency.

Set the Engraving Area
The following explanation is for Windows 95/98/Me. If you're using Windows NT4.0/2000/XP, then refer to the explanation in "3-1
Driver for Windows  Driver for Windows NT 4.0/2000/XP   Enter the Cutting Area."

From the [File] menu, click [Print Setup...].
The [Print Setup] dialog box appears.1

Make sure [MDX-650 (RML-1)] or [MDX-500 (RML-1)]
is specified as the printer, then click [Properties].
The property box appears.

2

Enter the size of the plate, then click [OK].
Next, click [OK] to close the [Printer Setup] dialog box.3

The white portion of the screen is the engraving area. Lay
out shapes and text inside the area.4
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Type in the Text

Click   , then click at the location where you want to type in

text.
While in this state, type in the text with the keyboard.

Draw a Shape
Click on the shape-drawing controls to draw the shapes.

Change the Size and Location of a Shape or Text

Click   , then click the shape or text.

Solid square (  ) and triangle (  ) pointers appear around the shape or text. To change the size, drag the pointers.

<Changing the Size>

You can freely change the size of the
object by dragging. To retain the
object’s vertical/horizontal aspect
when you change its size, hold down
the [Shift] key while dragging.

Drag to change the vertical size.

Drag to change the horizontal size.
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<Rotating and Slanting>

Clicking again makes the pointers change to circles (  ) and diamonds (  ).

<Moving the Location>

Drag to rotate the shape. Drag the “ ” to slant the shape.

To change the location, drag between
the pointers.

Start Engraving

Click the   .

The [Save As] dialog box appears.
To start engraving, click [OK].

Save the Data

Click the   .

The [Save As] dialog box appears.
Enter the name of the file and click [Save].
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Description of Controls

This opens new file.

This opens an existing file.

This saves the file, overwriting the previous data.

This starts engraving.

This deletes the selected object and copies it to the
clipboard.

This copies the selected object to the clipboard.

This copies the clipboard data to the screen.

This selects a shape or text.

This is used to reposition the vertices of a polygon,
changing its shape.

This zooms the screen in or out.

This types in the text

This draws the shapes

This makes an entry frame for text.

This changes the chosen text string to line
characters.

This performs flat-drag machining for the interior
of a shape or text.

These change the context of an object.

These set the direction of the text string.
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3D Engrave
This adds thickness to a flat (two-dimensional) graphic to create a relief (raised engraving).
You can also add thickness to images such as illustrations.

3D Engrave is a program for creating reliefs (raised engravings) and engravings on curved surfaces.
This section describes the steps for cutting a relief.
For detailed descriptions of the creation steps and more information about creating data for engraving,

Select the Output Device
For information, take a look at "Part 1  Installing the Software   1-2  Setting Up the Windows Version of the Program   Application
Settings."

Decide on the Size of the Relief

From the [Relief] menu, click [Relief Size].
The [Relief Size] dialog box appears.1

Enter the size of the relief and the resolution (the degree
of detail of the relief), then click [OK].2

The screen at right appears. The white area of the screen
is the where you design the relief.
The screen displayed at this time is called the "2D
screen." It's the screen for typing in text and
creating shapes.

3
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Creating Shapes and Entering Text
To create a shape, click one of the shape-drawing buttons and
drag.
To enter text, click the text-entry button, then click the location
where you want to insert text. While in this state, type in the text
with the keyboard.
To change the size of a shape or text, refer to "Dr. Engrave -
Changing the Size and Location of Shapes and Text."

Create a Raised Engraving (Relief)
Add thickness to shapes and text to create a relief.

Click the shape or text string you want for adding
thickness to select it.1

Click the  .
The [Create Relief] dialog box appears.
The dialog box may differ depending on the type of object you selected. The following screen shows the dialog box that appears
when creating a relief of shapes or text.
Make the settings for the required items for creating the relief, then click [OK].

2

These choose the configuration for pushing the
object up (or down).

These choose how to stack the relief.

These choose whether to push down or stack using
the value entered for the relief height.

This is for entering the angle of the base side when

 has been selected.

When this is selected, the relief of the
chosen object is smoothed.

This is for entering the direction of the relief ridge.
You can enter a value when a button other that

 has been selected.

Enter the height of the bottom of the relief.

Enter the thickness of the relief.
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Creating a Tool Path
A tool path is the path followed by the tool's blade tip. The tool path is generated from the cutting parameters that are presently set.
Before you create the tool path, make the settings for the cutting parameters. At the cutting parameters, make the settings for the compo-
sition of the workpiece, the type of tool, and the cutting process.

The display changes automatically to the screen at right,
and a three-dimensional view of the shape of
the relief appears.
This is called the "3D screen," and it displays the shape of
the relief and the tool path. You cannot edit shapes or text.

3

Click the  . When the tool path is created, it appears
in pink on the 3D screen.

2

From the [Cut] menu, click [Cutting Parameters].
The [Cutting Parameters] dialog box appears.
Make the settings for the necessary items for cutting, then
click [OK].

1

Make the settings for the tool specifications.

This chooses the composition of the cutting material.

This sets the depth for cutting.

This chooses the cutting process.
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Start Engraving

Click the   .
When the screen at right appears, click [OK].
Cutting starts.

Save the Data

Click the   .
The [Save As] dialog box appears.
Enter the name of the file and click [Save].

Checking the Cutting Results
If Virtual MODELA is installed and set up, then before you perform actual cutting you can check the shape that will be produced after
cutting on the screen.

For more information on how
to operate Virtual MODELA,
see the help for Virtual
MODELA.

From the [File] menu, click [Output Preview].
Virtual MODELA starts.1

The cutting data from 3D Engrave is imported into
Virtual MODELA.
An animated display of tool movement appears, and the
shape after cutting is gradually produced.

2
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Description of Controls

This types in the textThis opens new file.

This opens an existing file.

This saves the file, overwriting the previous data.

This deletes the selected object and copies it to the
clipboard.

This copies the selected object to the clipboard.

This copies the clipboard data to the screen.

This switches to a solid (three-dimensional)
display screen.
Display this screen when you want to check a tool
path or the shape of a relief.

This creates a tool path for engraving for the
selected shapes and text.
The tool path for engraving appears on the 3D
screen as a red line.

This creates the path that the tip of the blade traces
(the tool path).
The tool path for cutting appears on the 3D screen
as a pink line.

This starts cutting.

This switches to a flat (two-dimensional) shape-
editing screen.

This adds thickness to shapes, text, images or
other flat objects to create a relief (raised engrav-
ing).

This draws the shapes

These are used to retouch imported
images.

This zooms the screen in or out.
The mouse operations for the 2D screen and the
3D screen are different.

This changes the display location of the object.
This moves the screen display to show areas
outside the window which are not visible.

This changes the perspective of the relief when
you drag the screen.
This is available only during 3D screen.

This command expands or reduces the size of the
object shown to fill the screen.

These select the pen width for
retouching an image.

These set the direction of the text string.

These change the context of an object.

This is used to reposition the vertices of a polygon,
changing its shape.

This selects a shape or text.
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3-3 Cutting Using MODELA Player ver. 3

This section provides a step-by-step explanation of the basic procedures for cutting a solid objects.
In this section, it is assumed that you have already completed making the three-dimensional data for the solid object. It is assumed that
the three-dimensional data you have prepared is three-dimensional data in DXF format.

- Open the three-dimensional data with MODELA Player ver. 3 and set the cutting parameters.
- Install the tool and mount the workpiece.
- Set the reference point for cutting.
- Perform surfacing and start cutting.

This explanation takes the sample data for the MODELA programs as an example of a solid object to be cut.

1. Create the Cutting Data
Prepare the data to be cut, and set the cutting parameters with MODELA Player ver. 3.

 Open the File

From the [File] menu, click [Open...].
The [Open] dialog box appears.1

Choose the desired file and click [Open].2
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 Set the Cutting Parameters

The cutting parameters are the parameters for cutting the solid object.
For MODELA Player ver. 3, make these settings:

Cutting surface : The surface of the solid object to be cut
Size : The size of the finished object
Depth : The depth of cutting
Workpiece : The composition of the material to be cut
Cutting process : The stage of cutting
Tool : The diameter of the blade and the shape of the blade’s tip

   * When you set the parameters, the optimal movement speed, cutting-in amount, and so on when performing cutting under these
conditions are selected.
When you use materials and tools for which choices are already available, then unless an incorrect selection is made, there is
practically no chance of the tool breaking. Choose the loaded material and the installed tool.
When you use materials and tools for which choices are not available, the cutting parameters must be entered with great care. An
incorrect setting may result in overload that makes it possible for correct cutting to continue, and in worst cases may cause the tool to
break.

Make the settings for the cutting condi-
tions. Clicking [NEXT] advances the
setting screens in sequence from A to D.
Make the settings in order from A to D.
(Clicking A, B, C, or D in the figure
displays the corresponding setting screen,
this should not be used except when it's
necessary to make settings independently.)

A

B

C

D

A)  Select the direction of the object

Select the direction to be used for cutting the object.
In the figure at right, cutting from above is selected.

This displays the path of
the tool during cutting.

Click here to advance to
the next settings.
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C)  Set the maximum cutting depth

Make the setting for the maximum cutting depth.
Drag the spin dial up or down, or click on a number and enter a
value from the keyboard.
Clicking [Center] sets the depth at a location proportional to the
height.

D)  Tool diameter/Material/Finish

Tool
Set the type and diameter of the tool that is installed.

Material
Choose the composition of the loaded material.

Finish
When cutting a solid object on a modeling machine, an attractive
finish can be obtained by first performing rough (draft) cutting,
then performing fine cutting. Set to [Draft] for the first pass, and
to [Fine] for the second pass.

B)  Set the dimension

Make the setting for object's size. Drag the spin dial up or down,
or click on a number and enter a value from the keyboard.
Clicking [Resize] makes it possible to specify a ratio for the
dimensions.
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MODELA Player ver. 3 displays numerical values in 0.1-mm units. When you open a file containing setting values in
units smaller than 0.1 mm, the displayed values are rounded off to the nearest tenth of a millimeter. However,
although MODELA Player ver. 3 displays the values in 0.1-mm units, it uses the original setting values to perform
cutting. Also, the machine can display coordinate values in units of 0.01 mm. This means that the coordinate values
displayed during cutting may differ from the coordinates shown in MODELA Player ver. 3.

 Checking the Cutting Results
If Virtual MODELA is installed and set up, then before you perform actual cutting, you can check the shape that will be produced after
cutting.

From the [File] menu, click [Print Preview].
Virtual MODELA starts.1

The cutting data from MODELA Player ver. 3 is imported
into Virtual MODELA.
An animated display of tool movement appears, and the
shape after cutting is gradually produced.

2

   * For more information on how to operate Virtual MODELA,
see the help for Virtual MODELA.
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2. Install a Tool and Load Material
Refer to "User's Manual 1 - Setup & Maintenance" to install a tool and load material.

3. Set the Z-axis origin point
Set Z0 (the Z-axis origin point) on the surface of the loaded material.
For more information on how to set Z0, see "2-4  Setting the Origin Points (XY Origin Point and Z0) - Setting the Z0 Position."

 Save the file

From the [File] menu, click [Save As...].
The [Save As] dialog box appears.1

Choose where to save the file, type a filename, and click
[Save]. The file extension is “.mdj”.2
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4. Determine the Cutting Position
Align the mounted position of the workpiece with the cutting position of the object.

From the [Options] menu, click [Layout...].
The [Layout/Surfacing] dialog box appears.1

The blue rectangle is the size of the object. Drag this area
to set the object’s cutting position.
The lower-left point of the orange rectangle is the X- and
Y-axis origin point.

2

Double-clicking on one of the black circles displayed at
the four corners of the object lowers the tool at that
location. This lets you visually confirm the cutting
location.

3

Blue rectangle

Black circles

Continue by performing surfacing. See "5  Perform Surfacing" in
the next section.

To make only the setting for the cutting position without perform-
ing surfacing, click [OK].
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In addition to the method for determining the cutting position with MODELA Player ver. 3, there is a method for
setting the X and Y origin point with the machine. For more information about how to set the XY origin point, see "2-
4  Setting the Origin Points (XY Origin Point and Z0)."
The machine's XY origin point (0, 0) corresponds to the lower-left point of the orange rectangle in the MODELA
Player ver. 3 [Layout/Surfacing] dialog box. This means that the maximum cutting range matches the orange portion
only when the selection for [ORIGIN CHANGE] is [UNIT].

When [UNIT] is chosen for [ORIGIN CHANGE]

Maximum cutting range
(orange rectangle)

Machine origin point

When the XY origin point is set where you want

This portion is displayed on the MODELA
Player ver. 3 screen, but is outside the cutting
range.

User origin point

Maximum cutting range
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5. Perform Surfacing

Do not operate beyond capacity or
subject the tool to undue force.
The tool may break or fly off in a random
direction. If cutting beyond capacity is
mistakenly started, immediately turn off the
switch.

Perform dry cutting with no cutting
oil.
Such materials can
cause fire.

Do not insert the fingers between
the XY table and base or between
the head and Z cover.
Doing so may result in injury.

Do not insert the fingers between
the T-slot table and arms or between
the head and Z cover.
The fingers may be pinched, resulting in
injury.

Wear dust goggles and mask during
use.
Cutting dust may scatter, causing bodily
injury.

Head

Z cover
T-slot table

Arm

Do not wear gloves, a necktie or
wide-sleeved clothing.
They may become
caught in the tool,
resulting in injury.
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This cuts the surface of the loaded workpiece, creating a level surface. This is called “surfacing.”
Surfacing is used to eliminate unevenness in the surface of the workpiece.
When performing surfacing, set the depth-direction reference point to the highest location on the workpiece.

At the MODELA Player ver. 3 [Options] menu, click [Layout...]. The [Layout/Surfacing] dialog box appears.
   * Surfacing is not possible unless a file is open.

The slanted-line area is the surfacing range.

To change the surfacing range, deselect this.
You can change the size by dragging the solid
squares around the slanted-line area. You can
also change the size by entering values in the
[Width] and [Length] text boxes.

When surfacing finishes, MODELA Player ver. 3 automatically sets Z0 on the surface of the workpiece after surfacing.

6. Perform Cutting

A three-dimensional object is cut in two stages:  draft cutting and finishing.

First pass Draft cutting High-speed cutting that leaves a margin for finishing
Second pass Finishing High-precision cutting of the margin on the workpiece surface left by draft cutting

When finishing ends, cutting is complete.
Depending on the composition of the workpiece, however, finishing may not actual produce an attractive finish.
In such cases, use a file or the like to work it by hand.

Click [START] to start cutting.

Click [Start] to begin surfacing. When surfac-
ing finishes, the plane that has been surfaced
is set to the depth-direction reference point.

When surfacing ends, click [OK].

Enter the surfacing depth.
This sets the depth from the depth reference
point.
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 Pausing or stopping operation
While operation is in progress, press the [PAUSE] key.
Movement of the tool and table stops. Note that because this is not
an emergency stop, movement may continue for two or three
seconds before stopping.
The screen at right appears.

To continue with cutting

Turn the dial to move the arrow to [CONTINUE], then press the
[ENTER] key.

To end cutting
Stop sending data from MODELA Player ver. 3.

PAUSE>CONTINUE
      STOP

PAUSE>CONTINUE
      STOP

Open the [Printers] folder. If you're using Windows XP,
go to Control Panel and open [Printers and Faxes].1

Double-click the [MDX-650 (RML-1)] or [MDX-500
(RML-1)] icon.2

At the [Printer] menu, choose [Purge Print Jobs] or
[Cancel] to stop sending data.
If you're using Windows 2000/XP, choose [Cancel All
Documents].

3

Turn the dial to move the arrow to [STOP], then press the
[ENTER] key.4 PAUSE>STOP

      X/Y CUT SPEED

Depending on the model and the settings of the computer you’re using, data transmission may not stop
immediately, and the machine may operate.
If this happens, then either wait until operation has definitely stopped, or press the [PAUSE] key, move the
arrow to [STOP], then press the [ENTER] key.

NOTICE
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4-1 Cutting Area

Part 44  User's Reference

MDX-650A/650
The maximum cutting area of the MDX- 650A/650 is 650 mm x 450 mm x 155 mm (25-9/16 in. x 17-11/16 in. x 6-1/16 in.). If you
selected RML-1 as the command set, then when converted to coordinate values (step size: 1/100 mm), (x, y, z) = (50,000, 33,000,
10,500).
The actual cutting area differs according to the type of spindle installed.

When Use the High-torque Spindle (ZS-650T)
When a high-torque spindle (ZS-650T) is installed, the range that you can actually cut (in the height direction) is subject to the following
restrictions and is smaller than the maximum cutting range described earlier.

- Length of the installed tool
- Position of the XY table where the workpiece to cut is loaded
- If using a spacer for the T-slot table (ZA-600/500 series), the height of the spacer
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When Use the High-speed Spindle
When a high-speed spindle is installed, the range that you can actually cut (in the height direction) is subject to the following restrictions
and is smaller than the maximum cutting range.

- Length of the installed tool
- Position of the XY table where the workpiece to cut is loaded
- If using a spacer for the T-slot table (ZA-600/500 series), the height of the spacer
- If using a depth regulator nose, the stroke of the spindle due to the nut (approx. 5 mm)

If using the depth regulator nose
(nut loosened)

If not using the depth regulator nose
(nut tightened)
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MDX-500
The maximum cutting area of the MDX-500 is 500 mm x 330 mm x 105 mm (19-5/8 in. x 12-15/16 in. x 4-1/8 in.). If you selected RML-
1 as the command set, then when converted to coordinate values (step size: 1/100 mm), (x, y, z) = (50,000, 33,000, 10,500).
The actual cutting area differs according to the type of spindle installed.

When Use the High-torque Spindle (ZS-500T)
When a high-torque spindle (ZS-500T) is installed, the range that you can actually cut (in the height direction) is subject to the following
restrictions and is smaller than the maximum cutting range described earlier.

- Length of the installed tool
- Position of the XY table where the workpiece to cut is loaded
- If using a spacer for the T-slot table (ZA-600/500 series), the height of the spacer
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If using the depth regulator nose
(nut loosened)

If not using the depth regulator nose
(nut tightened)
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When Use the High-speed Spindle
When a high-speed spindle is installed, the range that you can actually cut (in the height direction) is subject to the following restrictions
and is smaller than the maximum cutting range.

- Length of the installed tool
- Position of the XY table where the workpiece to cut is loaded
- If using a spacer for the T-slot table (ZA-600/500 series), the height of the spacer
- If using a depth regulator nose, the stroke of the spindle due to the nut (approx. 5 mm)
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4-2 Coordinate System

The machine employs three separate coordinate systems (described below) according to the application or purpose of use.

Machine Coordinate
Under the machine coordinate system, the coordinates are
determined mechanically.  This system forms the basis of the
"work coordinates" which is explained later.  When [Go LIMIT
Pos.] is chosen for [MECHA MOVING] on the display menu, the
point to which the unit moves is the origin of the machine-
coordinate system (x, y, z) = (0, 0, 0). (The origin is fixed.)
The machine coordinate system basic unit is fixed as one step = 1/
100 mm (0.00039 in).

Work Coordinate
The origin of the machine coordinate system is fixed, but there is a
coordinate system in which the origin can be moved relative to the
machine coordinate system.  This system is called the work
coordinate system.
In the work coordinate system, the home position is the XY origin
and Z0 is the Z axis origin.  The origin of the work coordinates
can be set by setting the XY axis origin and Z0 (the Z axis origin).
The origin of the work coordinates is the standard point for cutting
against the attached workpiece.
The work coordinate system basic unit is fixed as one step = 1/100
mm (0.00039 in).

X

Y

Z

The origin of
the machine
coordinate

X

Y
Z

The origin of
the work
coordinate
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4-3 Operating Each Function

Changing to Japanese Messages on the Liquid-crystal Display
You can choose either English or Japanese for the display language.

Switch on the power while holding down the [EXIT] key.1

Turn the dial to move the arrow to [JAPANESE], then
press the [ENTER] key.2 >2 JAPANESE

             -<END>-

Messages on the display now appear in Japanese.3

   * To return the display to English-language messages, carry out Step 1 again. When the language-selection menu appears
(similar to the one in Step 1, but in Japanese), move the arrow to “English” and press the [ENTER] key.

Performing Repeat Cutting
The data buffer is the place where data received from the computer is stored temporarily. (The data in the data buffer can be erased by
switching off the power or clearing the data.
Pressing the [COPY] key calls up the all cutting data stored in the data buffer and executes the replotting procedure. When you perform
replotting, clear the data from the data buffer before sending the cutting for replotting from the computer.

Press the [COPY] key.
The screen at right appears.1
Turn the dial to move the arrow to [CLEAR COPY
BUFFER], then press the [ENTER] key.
Cutting data in the data buffer is lost.

2

>1 COPY START
 2 CLEAR COPY BUFFER

>2 CLEAR COPY BUFFER
             -<END>-
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Press the [COPY] key.
Turn the dial to move the arrow to [COPY START], then
press the [ENTER] key.

5 >1 COPY START
 2 CLEAR COPY BUFFER

Changing the Feed Rate or Spindle Speed During Cutting
The feed rate and spindle rotating speed set by the software can be changed while cutting is in progress.
This is done by first pausing the machine during cutting, then changing the feed rate or spindle rotating speed.  However, if the computer
subsequently sends a command to change the feed rate or spindle rotating speed, the setting will change as specified by the new
command.
The following method is appropriate for making delicate halfway adjustments to conditions previously set using software, etc.
For more information about the spindle-motor speed and the feed rate, refer to "2-3  Setting the Cutting Conditions."

While operation is in progress, press the [PAUSE] key.
Movement of the tool and table stops. Note that because
this is not an emergency stop, movement may continue
for two or three seconds before stopping.
The screen at right appears.

1 PAUSE>CONTINUE
      STOP

Install the tool (blade) and load the material. Use the
software to send the cutting data.3

After cutting has finished, remove the cut material and
load a new piece. Set the origin point if necessary.4
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Stopping the Cutting Process
If you want to change the shape to cut and redo cutting from the beginning, or if the data was different from what you wanted to cut, then
follow the steps below to stop operation.

PAUSE>CONTINUE
      STOP

PAUSE>STOP
      X/Y CUT SPEED

PAUSE>CONTINUE
      STOP

PAUSE>X/Y CUT SPEED
      Z DOWN SPEED

PAUSE:X/Y CUT SPEED
          <  2 mm/s>

While operation is in progress, press the [PAUSE] key.
Movement of the tool and table stops. Note that because
this is not an emergency stop, movement may continue
for two or three seconds before stopping.
The screen at right appears.

1

Stop sending data from the computer2
Stop execution of the program.3

Turn the dial to move the arrow to the item you want,
then press the [ENTER] key.2

Turn the dial to change the value, then press the [ENTER]
key.
To change another item, press the [EXIT] key, then repeat
steps 2 and 3.

3

Press the [EXIT] key to return to the screen at right.4

Turn the dial to move the arrow to [CONTINUE], then
press the [ENTER] key.
The paused state is canceled and cutting resumes.

5

   * You can also change the spindle speed while cutting is in progress by turning the dial. Note that the changed spindle speed is in effect
only during cutting.
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4-4 Descriptions of the Display Menus

1  SPEED OVER RIDE
1-1  X/Y CUT SPEED

Stored in Memory
Yes

Factory Default
2

Setting Range
0.5, 1 to 85

Steps
1

Description

This sets the feed rate along the X and Y axes during cutting.
For details, see "2-3  Cutting Condition Setting".

1-2  Z DOWN SPEED

Stored in Memory
Yes

Factory Default
2

Setting Range
0.5, 1 to 85

Steps
1

Description

This sets the feed rate along the Z axis during cutting.
For details, see "2-3  Cutting Condition Setting".

1-3  X/Y MOVE SPEED

Stored in Memory
Yes

Factory Default
85

Setting Range
0.5, 1 to 85

Steps
1

Description

This sets the speed of movement along the X and Y axes when the tool
is raised.
For details, see "2-3  Cutting Condition Setting".

 1-1 X/Y CUT SPEED
          <  2 mm/s>

 1-2 Z DOWN SPEED
          <  2 mm/s>

 1-3 X/Y MOVE SPEED
          < 85 mm/s>
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2  SPINDLE RPM

Stored in Memory
Yes

Factory Default
3000

(High Torque)

5000
(High Speed)

Setting Range
3000 to 12000
(High Torque)

5000 to 20000
(High Speed)

Steps
100

Description

This specifies the spindle speed.
For details, see "2-3  Cutting Condition Setting".

  2 SPINDLE RPM
         < 5000 RPM>

3  MECHA MOVING

 3 >1 Go ORIGIN Pos.
    2 Go Z0 Pos.

 3  9 Go LIMIT Pos.
   10 To Main MENU

Description

This moves the tool to the specified location.

1-4  Z UP SPEED

Stored in Memory
Yes

Factory Default
85

Setting Range
0.5, 1 to 85

Steps
1

Description

This sets the speed of movement along the Z axis when the tool is
raised.
For details, see "2-3  Cutting Condition Setting".

 1-4 Z UP SPEED
          < 85 mm/s>
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4  ORIGIN CHANGE

Stored in Memory
Yes

Factory Default
USER

Selection Choices
USER, LIMIT,

CENTER

  4 ORIGIN  CHANGE
              <USER>

Description

This specifies the location of the origin point for the X and Y axes.
For details, see "2-4  Setting the Origin Points (XY Origin Point and
Z0)".

5  MOVING MODE
5-1  SPINDLE CONTROL

Stored in Memory
Yes

Factory Default
ON

Selection Choices
ON, OFF,

EXTERNAL
ONLY

Description

This chooses the method of control for the spindle motor.

ON When a command to rotate the spindle is received, a
rotate signal is issued to the internal spindle. A signal is
also issued to the EXT2 connector at the same time.

OFF Even when a command to rotate the spindle is received,
not rotate signal is issued to the internal spindle circuit.
Similarly, no signal is issued to the EXT2 connector.

EXTERNAL ONLY Even when a command to rotate the spindle is received,
not rotate signal is issued to the internal spindle circuit.
A signal is issued only to the EXT2 connector.

5-2  OVER AREA

Stored in Memory
Yes

Factory Default
CONTINUE

Selection Choices
CONTINUE,

PAUSE

Description

This selects the action when the tool returns from a coordinate outside
the cutting range to a coordinate inside the range.  (The tool cannot
actually be moved outside the cutting range, but the machine's internal
processing handles this as if it had.)
CONTINUE Operation is not paused upon return to the cutting

range.  Cutting continues without interruption.
PAUSE Operation is paused when the tool returns to the

cutting range.

 5-1 SPINDLE CONTROL
                <ON>

 5-2 OVER AREA
          <CONTINUE>

1 2 1 2

Operation is pausedOperation continues

: Tool path
: Coodinate point

"CONTINUE" "PAUSE"

Cutting Area
(500 mm x 330 mm)
(9-13/16 x 5-7/8 in.)

Cutting Area
(500 mm x 330 mm)
(9-13/16 x 5-7/8 in.)
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5-3  SMOOTHING

Stored in Memory
Yes

Factory Default
ON

Selection Choices
OFF, ON

Description

Smoothing is a function for cutting smooth arcs and circles.  This
selects the type of smoothing.  Smoothing can also be switched off.
When shipped from the factory, this is set to [ON.]  If arcs cannot be
cut well using this setting, try changing it to [OFF.]

 5-3 SMOOTHING
                <ON>

5-4  ACCELERATION

Stored in Memory
Yes

Factory Default
0.3

Selection Choices
0.05, 0.1, 0.3

Description

This chooses the acceleration when moving the tool and table.
Normally the default value (0.3 G) can be left unchanged. When
cutting material that creates a high load, on rare occasions the
acceleration may make it impossible to perform cutting. In such cases,
the value should be changed.

 5-4 ACCELERATION
              <0.3G>

6  COMMAND SET

Stored in Memory
Yes

Factory Default
AUTO

Selection Choices
MODE-1,
MODE-2,

AUTO

Description

This selects the RML-1 command mode. When set to [AUTO,]
[MODE-1] or [MODE-2] is determined automatically.  If automatic
determination is not made correctly, find out what instruction system
the application software (or driver software) uses for data that is sent,
and change this setting to [MODE-1] or [MODE-2.]  To determine
which mode your software is sending data in, refer to the documenta-
tion for the software.

 6 COMMAND SET
              <AUTO>

7  CONNECTION

Stored in Memory
Yes

Factory Default
AUTO

Selection Choices
AUTO, SERIAL,

PARALLEL

Description

This sets the type of interface used for connection to the computer.
When set to [AUTO], the port is determined automatically.  The
communication parameters in effect when a serial connection is used
are according to the parameters of the panel settings.
If the interface cannot easily be determined when set to [AUTO], the
setting should be made manually.

 7 CONNECTION
              <AUTO>
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8  SERIAL PARAMETER
8-1  STOP BIT

Stored in Memory
Yes

Factory Default
1

Selection Choices
1, 2

Description

This sets the number of stop bits for the communication parameters.

8-2  DATA BIT

Stored in Memory
Yes

Factory Default
8

Selection Choices
7, 8

Description

This sets the data bit length for the communication parameters.

8-3  PARITY BIT

Stored in Memory
Yes

Factory Default
NONE

Selection Choices
NONE, ODD,

EVEN

Description

This makes the setting for parity checking for the communication
parameters.

 8-1 STOP BIT
                 <1>

 8-2 DATA BIT
                 <8>

 8-3 PARITY BIT
              <NONE>

8-4  BAUD RATE

Stored in Memory
Yes

Factory Default
9600

Selection Choices
4800, 9600,

19200, 38400

Description

This sets the bit rate (transmission speed) for the communication
parameters.

 8-4 BAUD RATE
              <9600>
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8-5  HAND SHAKE

 8-5 HAND SHAKE
         <HARD-WIRE>

Stored in Memory
Yes

Factory Default
HARD-WIRE

Selection Choices
HARD-WIRE,
XON/XOFF

Description

This sets the type of hand shake for the communication parameters.

9  COMPENSATE

Description

This compensates for differences between the length specified by the
program and the actual cutting length. This can correct for error due to
temperature or humidity, as well as error due to individual differences
from one machine to another.
If you change the compensation value, then switch the power off and
back on. The changed compensation value is enabled after the power
has been reset.

 9-1 X-COMPENSATE
          <100.00 %>

 9-2 Y-COMPENSATE
          <100.00 %>

 9-3 Z-COMPENSATE
          <100.00 %>

Stored in Memory
Yes

Factory Default
100

Setting Range
99.90 to 100.10

Steps
0.01

10  OTHERS
10-1  SENSOR MODE

Description

The Z0 sensor included with the unit is used to set the Z0 point on the
surface of the workpiece.
For details, see "2-4  Setting the Origin Points (XY Origin Point and
Z0). - Setting Z0 with the Z0 Position Sensor".

10-1 SENSOR MODE
 Please Cursor Move

10-2  SPINDLE UNIT

Stored in Memory
Yes

Factory Default
HIGH TORQUE

Selection Choices
HIGH TORQUE,

HIGH SPEED

Description

This sets the type of the installed spindle.
If a high-torque spindle is installed, choose [HIGH TORQUE]. If a
high-speed spindle is installed, choose [HIGH SPEED].

10-2 SPINDLE UNIT
       <HIGH TORQUE>
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10-4  SENSOR HEIGHT

Stored in Memory
Yes

Factory Default*
15000

Setting Range
0 to 30000

Steps
10

Description

The thickness of the Z0 sensor can vary slightly due to conditions of
temperature or humidity.  This allows the sensor thickness to be
adjusted to match actual thickness.
*The value that is set when shipped from the factory varies from one
unit to another .

10-4 SENSOR HEIGHT
          <15000 um>

10-5  REVOLUTION TIME

Description

This displays the total rotation time of the spindle.  The rotation time
cannot be returned to [0] (zero).
The displayed time should be used as an indicator for performing
periodic maintenance.  (For more information about maintenance,
refer to the separate "Setup & Maintenance.")

10-5 REVOLUTION TIME
             0 Hour

11  SELF MODE
11-1  SURFACE CUT

Description

This menu item is for performing surfacing of the vacuum plate on the
optionally available ZV-500A vacuum table. For more information,
refer the User's Manual for the ZV-500A vacuum table.
* This menu item must not be used to perform surfacing for a

workpiece.

11-1 SURFACE CUT
Are You Sure?[ENTER]

10-3  BUZZER

Stored in Memory
Yes

Factory Default
ON

Selection Choices
ON, OFF

Description

This switches on or switches off the confirmation sound heard when a
control key is pressed.

10-3 BUZZER
                <ON>
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 13 ATC
             

12  Rotary Control (MDX-650A/650 only)

Description

This menu item is available when you are employ the optional rotary
axis unit. If the rotary axis unit is not installed, you cannot enter this
menu.

 12 ROTARY CONTROL
             

13  ATC (MDX-650A only)

Description

This menu item is available when you are employ the optional ATC
unit. If the ATC unit is not installed, you cannot enter this menu.

14  To Coordinate

Description

This displays the current tool location and spindle speed.
The units of measurement are in machine steps (1 step = 0.01 mm).

*X      0  Y      0
 Z      0   5000 RPM
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4-5 What to Do If...

When the machine does not work...

Is operation paused?

Is the power switched on?

Is NC code chosen as the command set?

Cancel the paused state.

Make sure the machine is powered up.

Set the command set to RML-1. For more information about how to
make the setting, see "Introduction" in this manual.

When the spindle does not rotate ...

Is the SPINDLE COVER open?

Is [SPINDLE CONTROL] set to [OFF] or [EXTER-
NAL ONLY]?

Close the SPINDLE COVER.

Refer to "Descriptions of the Display Menus" and change the setting
for "SPINDLE CONTROL" to "ON."

Data cannot be sent

When using a serial connection, do the communica-
tion parameters for the machine match the settings
for the computer?

Has the connection cable come loose?

Is the correct connection cable being used?

Is the correct output device set for the applica-
tion or driver software?

Refer to “2-2  Setting the Connection Parameters” to make the correct
settings.

Make sure the connection cable is plugged in securely with no
looseness at either end.

The type of connection cable varies according to the computer being
used.  Also, some application software requires the use of a special
cable.  Make sure the correct cable is being used.

Refer to the manual for the application or driver software to set the
output device correctly.
If you're using the included "2.5D DRIVER," refer to "Part 1 Install-
ing the Software."

The power does not come on...

Has the power cord come loose? Make sure the power cord is plugged in securely with no looseness at
either end.
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The message "Unusable Parameter" appears and
operation stops
This appears when a specified parameter value is out of range.
In particular, this appears when the tool-down position (Z1) is set at a lower location than the Z-axis cutting range.
When cutting material of uneven thickness using the depth regulator nose, set the tool-down position at a lower height than the actual
cutting depth (see "User's Manual 1 - Setup & Maintenance"). As a result, the tool-down position (Z1) is set at a location lower than the
Z-axis cutting range.
To clear the error message, switch off the power.
To avoid errors, place a flat board under the workpiece to serve as a lifting base.

Changes to the feed rate and rotating speed of the
spindle motor made while cutting is in progress do not
take effect
Even when the machine is paused during cutting and the setting for the spindle rotating speed or feed rate is changed using the display
menus, the changed setting may not take effect.
This is due to the following causes.
- After the setting was changed, a command for spindle rotating speed or feed rate contained in data already sent was executed.
- After the setting was changed, a command changing the spindle rotating speed or feed rate was sent from the computer.
In such cases, change the setting on the computer.

The expected cutting precision is not obtained
The expected cutting precision may not be obtained when the cutting parameters and the end mill do not match.
This is due to the following causes.
- The amount of blade extension for the end mill is too long.
- The shank diameter of the blade is too narrow with respect to the cutting parameters.
In such cases, change the cutting parameters (the end mill's amount of blade extension or shank diameter) to match the object being cut.
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4-6 Error Messages

An error message appears when the data being sent contains an error explained under "Description" in the table. However, only informa-
tion about the error appears on the display -- sending of data is not stopped, and the next operation is not prevented.
Pressing the [ENTER] key clears the error message from the display and pauses operation.
If an error occurs, correct cutting may become impossible. We recommend that you stop cutting and check the settings.

Description

Appears if an instruction that the machine cannot interpret is sent.  This error is generated if an
instruction from the [MODE-2] set is sent when the unit has been set to recognize [MODE-1,] or
viceversa.  Change the setting for the recognized instruction set, using the control panel, and this
error should no longer occur.

Command Not         
       Recognized

Appears if the number of parameters differs from the permissible number.

Appears if the value specified for a parameter is out of the permissible range.

Appears if an unusable character is specified.

Appears if coordinates being overflowed.

Appears if the polygon buffer is full.

Appears if an output instruction is sent from the computer during execution of a previous output
instruction.  More precisely, there is a certain amount of delay between the moment an output
instruction is given and the instant actual output begins.  This error message appears if the new
output request arrives during this delay time.  (The delay time can be set using the [ESC].M
instruction.)

Appears if a device control instruction that the machine cannot interpret is sent.

Appears if an invalid parameter has been specified for a device control instruction.

Appears if the value for a device control instruction parameter exceeds the permissible limit.

Wrong Number        
       of Parameters

Bad Parameter

Unknown             
     Character set

Position Overflow

Buffer Overflow

Appears if the number of parameters for a device control instruction is more than that permis-
sible.

I/O Err:Termination 
               Error

I/O Err: Out of     
    Parameter range

I/O Err: Wrong      
           Parameter

I/O Err: Command    
      Not Recognized

I/O Err: Output     
     Request Overlap

Error message
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Error message Description

Appears if a framing error, parity error, or overrun error occurs at the time of data reception.
(There is a problem with one of these settings: Baud Rate, Parity, Stop Bits, or Data Bits.  The
protocol settings for the machine must be made correctly in order to match the settings your
computer is set to use.)

Appears if the I/O buffer has overflowed.  (There is a problem with the connecting cable, or the
settings for Handshaking.  Make sure you are using a cable appropriate for the computer being
used.  Also, check that the setting for Handshaking is correct.)

I/O Err:Framing/Par-
           ity Error

I/O Err: Buffer     
           Overflow

Appears if an undefined communication error occurs.I/O Err:Indetermina-
            te Error
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4-7 Other Messages

Besides error messages related to commands or communication parameters, the following messages may also appear on the display.

Error message Description

This appears when either the cable connecting the safety cover and the main unit or the key
connector is disconnected.
Switching off the power clears the message.
Make the connections correctly, then switch on the power.

EMERGENCY STOP      
EXT1 IS NOT CONNECT

EMERGENCY STOP      
MOTOR LOCK   XYZS

The machine stops automatically if an excessive load is placed on the spindle or the X, Y, or Z
axis during cutting.  The message shown at left appears at this time.
Switching off the power clears the message.
The overload may be due to excessive hardness of the material, an excessive amount of cutting-
in, a feed rate that is too fast, or operation being impeded by cuttings. Take action such as
changing the cutting parameters or cleaning the machine to eliminate the cause of the over load.

EMERGENCY STOP
SP/SFTY COVER OPEN

This appears when the spindle cover or the safety cover is opened during operation.
SP: Spindle cover SFTY: Safety cover

Switching off the power clears the message.
Close the covers, then switch on the power.

CAUTION!            
SP    COVER OPEN

This appears when the spindle cover is opened during standby.
SP: Spindle cover

Closing the cover clears the message and returns the display to the coordinate view screen.

10-1 SENSOR MODE
 Please Cursor Move

This appears when the sensor mode is entered.

10>1 SENSOR MODE    
   Z0SENSOR NOTHING

This error appears if the Z0 sensor is not connected when entering the sensor mode.
The display shows the message for several seconds, then returns to the previous screen.
Connection the Z0 sensor before entering the sense mode.

10>1 SENSOR MODE    
      SET Z ORIGIN!

This appears when Z0 is set in the sensor mode.

Comp. Effect After  
     Power On Again

This appears when the value for [COMPENSATE] is changed.
After setting the distance compensation value, switch the power off and on again to activate the
change.

CAN'T COPY          
TOO BIG DATA

When the amount of cutting data exceeds the capacity of the data buffer, this message appear
when an attempt is made to perform recutting with this data. The data cannot all fit in the data
buffer, so repeat cutting cannot be performed.

CAN'T COPY          
BUFFER EMPTY

This message appears if repeat cutting is attempted when the data buffer is empty. Send cutting
data before performing repeat cutting.
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Error message Description

This appears when the [COPY] key is pressed to attempt to perform copying while the spindle
cover or the safety cover is open.
Closing the cover pauses operation. To perform copying, choose [CONTINUE]. To stop
copying, choose [STOP].

CAN'T COPY          
COVER OPEN
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4-8 List of RML-1 Instructions

Instruction Format Parameter Range  [Default]

mode1

@ Input Z1 & Z2 @ Z1, Z2 Z1 Position on Z1 -10500 to 0  [0]

Z2 Position on Z2 0 to +10500  [0]

H Home H None

D Draw D x1, y1, x2, y2, ..... , xn, yn xn, yn Absolute coordinate *1

M Move M x1, y1, x2, y2, ..... , xn, yn xn, yn Absolute coordinate *1

I Relative Draw I x1, y1, x2, y2, ..... , xn, yn Relative coordinate *1

                                xn, yn

R Relative Move R x1, y1, x2, y2, ..... , xn, yn Relative coordinate *1

                                xn, yn

V Velocity Z-axis V f f Feed rate for Z axis 0 to 85  [mm/sec]  [2 [mm/sec]]

F Velocity X,Y-axis F f f Feed rate for X and Y axis 0 to 85  [mm/sec]  [2 [mm/sec]]

Z XYZ-axis Z x1, y1, z1, ..... , xn, yn, zn xn, yn XY coordinate *1

Simultaneous Feed Z x1, y1, z1, ..... , xn, yn, zn zn Z coordinate *1

W Dwell W t t Dwell time 0 to 32767  [msec]  [2 [msec]]

^ Call mode2 ^ [mode2] [parameter].....

                       [parameter] [;]

mode2

Instruction Format Parameter Range  [Default]

DF Default DF; None

IN Initialize IN; None

PA Plot Absolute PA x1, y1 (,x2, y2, ..... , xn, yn); xn, yn Absolute XY coordinate *1

PA;

PD Pen Down PD x1, y1 (,x2, y2, ..... , xn, yn); xn, yn XY coordinate *1

PD;

PR Plot Relative PR x1, y1 (, x2, y2, ..... , xn, yn Relative XY coordinate *1

                                xn, yn);

PR;

PU Pen Up PU x1, y1 (,x2, y2, ..... , xn, yn); xn, yn XY coordinate *1

PU;

VS Velocity select VS s; s Feed rate for X and Y axis 0 to 85  [mm/sec]  [2 [mm/sec]]

VS;

* 1 : -(223-1) to +(223-1)
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Instruction Format Parameter Range  [Default]

mode1, mode2 common instruction

!DW Dwell !DW  t  [terminator] t Dwell time 0 to 32767  [0]

!MC Motor Control !MC  n  [terminator] n Motor ON/OFF switching -32768 to 32767  [motor ON]

!MC  [terminator]

!NR Not Ready !NR  [terminator] None

!PZ Set Z1&Z2 !PZ  z1 (,z2)  [terminator] z1 Z1 coordinates -10500 to 0  [0]

z2 Z2 coordinates 0 to 10500  [0]

!RC Revolution !RC  n  [terminator] n Spindle motor 0 to 15

               revolution speed

!VZ Velocity Select !VZ  s  [terminator] s Feed rate (Z axis) 0 to 85  [mm/sec]  [2 [mm/sec]]

                 Z-axis

!ZM Z-axis Move !ZM  z  [terminator] z Z coordinate -10500 to 0

!ZO Set Z0 !ZO  z  [terminator] z Z machine coordinate -10500 to 0

!ZZ XYZ-axis !ZZ x1, y1, z1, ....., xn, yn XY coordinate *1

Simultaneous Feed zn Z coordinate *1

!ZE Extention Axis Move !ZE Xx1, Yy1, Zz1, Aa1, Xx2, ....., XY, Z, A Axis name (alphabet) A to Z or a to z

Xxn, Yyn, Zzn, Aan  [terminator] xn, ynzn Coordinate *1

zn
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Instruction Format Parameter Range    ([ ] is default) Explanation

Handshake Instructions

ESC .B [ESC].B None Outputs the current remaining buffer capacity to

   Buffer Capacity the Output Remaining computer.

ESC .M [ESC].M<P1>;<P2>; P1: Delay time 0-32767 (msec) Sets handshake output specifications.

   Set Handshake <P3>;<P4>;<P5>;<P6>:  [0 (msec)]

   Output P2: Output trigger character  [0 (Sets nothing)]

   Specifications (1) P3: Echo terminator  [0 (Sets nothing)]

P4: Output terminator  [13 ([CR])] Note: When you specify some values to <P4> and

P5: Output terminator  [0 (Sets nothing)] <P5>, always set 0 to <P6>. When you specify

P6: Output initiator  [0 (Sets nothing)] some value to <P6>, always set 0 to <P5>.

ESC .N [ESC].N<P1>;<P2>; P1: Intercharacter delay 0-32767 (msec) Sets an intercharacter delay, and also an Xoff

   Set Handshake  [0 (msec)] character for performing the Xon/Xoff handshake.

    Output <P3>; ••••• ;<P11>: P2-P11  [All 0 (Sets nothing)]

   Specifications (2)  : Xoff character

   (for Xon/Xoff)

   Immediate response

   character

   (for ENQ/ACK)

ESC .H [ESC].H<P1>;<P2>; P1: The number of bytes 0-15358 (byte) When receiving the ENQ character set by <P2>,

   Sets ENQ/ACK <P3>; •••••••• ;<P12>:       for data block  [80 (byte)] compares the value set by <P1> and the remaining

   Handshake Mode1 P2: ENQ character  [0 (Sets nothing)] buffer capacity, and returns the ACK character to

P3-P12  [All 0 (Sets nothing)] the host computer when the remaining buffer

 : ACK character (only capacity is larger. The [ESC].H with no parameter

   when <P2> is set) performs a dummy handshake.

4-9 Device Control Instructions

The Device Control instructions determine how communication between the machine and the computer will be handled using the RS-
232C interface; and also are employed when relaying to the computer the status of the machine.  Some of them can be used to format the
output for RML-1 instructions.
A Device Control instruction is composed of three characters: ESC  (1Bh), a ".", and an uppercase letter.  There are also two types of
device control instructions: one carries parameters and the other does not.
Parameters can be omitted. Semicolons, " ; " are used as separators between parameters.  A semicolon without parameters means that
parameters have been omitted. Device Control instructions with parameters require a terminator to indicate the conclusion of the
instruction. A colon " : " is used as the terminator, and it must not be omitted.
No terminator is necessary for Device Control instructions without parameters.
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Instruction Format Parameter Range    ([ ] is default) Explanation

ESC .I [ESC].I<P1>;<P2>; P1: Limit of the remaining 0-15358 (byte) Used for performing the Xon/Xoff handshake and

   Set Xon/Xoff <P3> ; •••••••• ;<P12>: buffer capacity [80 (byte)] the ENQ/ACK handshake  mode 2.

   Handshake and (for Xon/Xoff) The [ESC].I instruction with no parameter performs

   ENQ/ACK The number of data a dummy handshake.  In a dummy handshake,

   Handshake Mode2 block bytes (for ENQ/ always returns the ACK character to the host

ACK (mode2)) computer, regardless of the remaining buffer

P2: ENQ character  [0 (Sets nothing)] capacity, when receiving the ENQ character.

(for ENQ/ACK (mode2))

0 (for Xon/Xoff)

P3-P12  [All 0 (Sets nothing)]

 : Xon character (for Xon/Xoff)

  ACK character

(for ENQ/ACK (mode2))

ESC .@ [ESC].@ P1;P2: P1: Ignored Controls the DTR signal (No. 20 pin of RS-232C).

   Controls DTR P2: DTR signal control 0-255            [1] An even number parameter (e.g. 0) always sets the

DTR signal to High without performing the

hardware handshake. An odd number parameter

(e.g. 1) performs the hardware handshake and

controls the DTR signal according to the remaining

buffer capacity.

Status Instructions

ESC .O [ESC].O None Outputs the status codes of the machine shown in

   Outputs the Status the table below.

   of Buffer, Pause
Code Meaning
0 Data remaining in buffer.
8 Buffer empty.
16 Data remaining in buffer. The machine

being paused
(Pause On being displayed).

24 Buffer empty. The machine being
paused (Pause On being displayed).
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Instruction Format Parameter Range    ([ ] is default) Explanation

ESC .E [ESC].E None Outputs an error code related to RS-232C interface

   Output RS-232C (see the table below), and clears the error

   Error Code simultaneously. At the same time, the error being

displayed is canceled.

ESC .L [ESC].L None The machine outputs the size of the I/O buffer to

   Output I/O buffer the computer when receiving this instruction.

   size It usually outputs 1024 (bytes).

Abort Instructions

ESC .J [ESC].J None Aborts both the currently executed device control

   Abort Device instruction and output.

   Control Instruction

ESC .K [ESC].K None Continues to execute the RML-1 instruction

   Abort RML-1 in operation, aborts other incoming RML-1

   Instruction instructions and clears the data buffer.

ESC .R [ESC].R None Initializes all settings established by the device

   Initialize Device control instructions. Execution of [ESC].R brings

   Control Instruction the same states as the following device control

instructions are executed.

  [ESC].J, [ESC].M:, [ESC].N:, [ESC].H:,

  [ESC].I: and [ESC].@:

Error Possible cause and action
code
0 No I/O errors
10 Cause: after execution of an output

command, other output instructions are
sent before the output was not completed.
Action: let the computer to read the
machine's output by the output instruction
and then send another output instruction.

11 Cause: an error occurs in a device
control instruction.
Action: correct your program.

13 Cause: parameters are overflowing.
Action: correct your program.

14 Cause: the number of the parameters set
is more than specified or a colon ‘:’ was
not used to terminate.
Action: correct your program.

15 Cause: framing error, parity error or over-
run error at the time of data receipt .
Action: match the communication
protocols of both computer and the
machine (baud rate, data bit length,
stop bit length).

16 Cause: the I/O buffer overflows.
Action: This error does not occur when
hardware handshake is performed, but
may occur when software handshake is
performed. If this error occurs, check the
remaining buffer capacity and send less
data than the remaining buffer capacity.
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4-10 Display Menus Flowchart

 1 ENGLISH
>2 JAPANESE
             -<END>-

      MDX-650
   Roland DG Corp.

Hit "ENTER" >RML-1
Select MODE  NC-CODE

MODE   : RML-1
SPINDLE: HIGH TORQUE

*X      0  Y      0
 Z      0   5000 RPM

  3 MECHA MOVING
  4 ORIGIN CHANGE
  5 MOVING MODE
  6 COMMAND SET
  7 CONNECTION
  8 SERIAL PARAMETER
  9 COMPENSATE
 10 OTHERS
 11 SELF MODE
 12 ROTARY CONTROL
 13 ATC*
 14 To Coordinate
    -<RML/MODELING>-

 1>1 X/Y CUT SPEED
   2 Z DOWN SPEED

   3 X/Y MOVE SPEED
   4 Z UP SPEED
   5 To Main MENU
             -<END>-

 1-1 X/Y CUT SPEED
          <  2 mm/s>

 1-2 Z DOWN SPEED
          <  2 mm/s>

 1-3 X/Y MOVE SPEED
          < 85 mm/s>

 1-4 Z UP SPEED
          < 85 mm/s>

  2 SPINDLE RPM
         < 5000 RPM>

 3 >1 Go ORIGIN Pos.
    2 Go Z0 Pos.

    3 Go VIEW Pos.
    4 Go Z1 Pos.
    5 Go Z2 Pos.
    6 Go MAX Pos.
    7 Go USER Origin
    8 Go CENTER Pos.
    9 Go LIMIT Pos.
   10 To Main MENU
             -<END>-

POWER ON

X/Y CUT
SPEED

Z DOWN
SPEED

X/Y MOVE
SPEED

SPEED
SETTING

SPINDLE
RPM

MECHA
MOVING

Z UP
SPEED

[ENTER]

[ENTER][EXIT]

Next Page

[EXIT]

 >1 SPEED SETTING
  2 SPINDLE RPM

Main Menu

[EXIT] 0.5/1 to 85 mm/s
         (In steps of 1 mm/s)

0.5/1 to 85 mm/s
         (In steps of 1 mm/s)

0.5/1 to 85 mm/s
         (In steps of 1 mm/s)

0.5/1 to 85 mm/s
         (In steps of 1 mm/s)

[HIGH TORQUE] mode selected: 3000 to 12000 RPM
[HIGH SPEED] mode selected : 5000 to 20000 RPM     (In steps of 100 RPM)

Select "RML-1"

Switch on the power while 
holding down the [EXIT] key

[ENTER]

Select "ENGLISH"

*MDX-650A only

MDX-650A/650
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  4 ORIGIN  CHANGE
              <USER>

 5-1 SPINDLE CONTROL
                <ON>

 5-2 OVER AREA
          <CONTINUE>

 5-3 SMOOTHING
                <ON>

 5-4 ACCELERATION
              <0.3G>

 5>1 SPINDLE CONTROL
   2 OVER AREA

   3 SMOOTHING
   4 ACCELERATION
   5 To Main MENU
             -<END>-

SPINDLE CONTROL

OVER
AREA

SMOOTHING

ORIGIN
CHANGE

MOVING
MODE

ACCELERATION

 8>1 STOP BIT
   2 DATA BIT

   3 PARITY BIT
   4 BAUD RATE
   5 HAND SHAKE
   6 To Main MENU
             -<END>-

SERIAL PARAMETER

 7 CONNECTION
              <AUTO>

CONNECTION

 6 COMMAND SET
              <AUTO>

COMMAND
SET

Next Page

Previous Page

[EXIT]

 8-1 STOP BIT
                 <1>

 8-2 DATA BIT
                 <8>

 8-3 PARITY BIT
              <NONE>

 8-4 BAUD RATE
              <9600>

STOP
BIT

DATA
BIT

PARITY
BIT

BAUD
RATE

 8-5 HAND SHAKE
         <HARD-WIRE>

HAND
SHAKE

[EXIT]

USER/LIMIT/CENTER

ON/OFF/EXTERNAL ONLY

CONTINUE/PAUSE

ON/OFF

0.05G/0.1G/0.3G

MODE-1/MODE-2/AUTO

AUTO/SERIAL/PARALLEL

1/2

7/8

NONE/ODD/EVEN

4800/9600/19200/38400

HARD-WIRE/XON/XOFF
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10-1 SENSOR MODE
 Please Cursor Move

10-2 SPINDLE UNIT
       <HIGH TORQUE>

10-3 BUZZER
                <ON>

10-4 SENSOR HEIGHT
          <15000 um>

10>1 SENSOR MODE
   2 SPINDLE UNIT

   3 BUZZER
   4 SENSOR HEIGHT
   5 REVOLUTION TIME
   6 To Main MENU
             -<END>-

 9>1 X-COMPENSATE
   2 Y-COMPENSATE

   3 Z-COMPENSATE
   4 To Main MENU
             -<END>-

SENSOR
MODE

SPINDLE
UNIT

BUZZER

COMPENSATE

OTHERS

SENSOR
HEIGHT

10-5 REVOLUTION TIME
             0 Hour

REVOLUTION
TIME

 ROTARY CONTORL

Previous Page

[EXIT]

 9-1 X-COMPENSATE
          <100.00 %>

 9-2 Y-COMPENSATE
          <100.00 %>

 9-3 Z-COMPENSATE
          <100.00 %>

X-COMPEN-
SATE

Y-COMPEN-
SATE

Z-COMPEN-
SATE

[EXIT]

11-1 SURFACE CUT
Are You Sure?[ENTER]

11>1 SURFACE CUT
   2 To Main Menu

SURFACE
CUT

SELF
MODE

[EXIT]

  12 ROTARY CONTROL

99.90 to 100.10%
(In steps of 0.01%)

HIGH TORQUE/HIGH SPEED

ON/OFF

0 to 30000 um
(In steps of 10 um)

(MDX-650A only)

99.90 to 100.10%
(In steps of 0.01%)

99.90 to 100.10%
(In steps of 0.01%)

 To Coordinate

*X      0  Y      0
 Z   1500   5000 RPM

 ATC

  13 ATC
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PAUSE>CONTINUE
      STOP

      X/Y CUT SPEED
      Z DOWN SPEED
      X/Y MOVE SPEED
      Z UP SPEED
      SPINDLE RPM
             -<END>-

PAUSE:X/Y CUT SPEED
          <  2 mm/s>

PAUSE:Z DOWN SPEED
          <  2 mm/s>

PAUSE:SPINDLE RPM
         < 5000 RPM>

Press the [PAUSE] key

X/Y CUT
SPEED

CONTINUE

Z DOWN
SPEED

STOP

SPINDLE
RPM

PAUSE:Z UP SPEED
          < 85 mm/s>

Z UP
SPEED

PAUSE:X/Y MOVE SPEED
          < 85 mm/s>

X/Y MOVE
SPEED

[EXIT]

Stopping the cutting process

Cutting continues

0.5/1 to 85 mm/s
         (In steps to 1 mm/s)

0.5/1 to 85 mm/s
         (In steps to 1 mm/s)

0.5/1 to 85 mm/s
         (In steps to 1 mm/s)

0.5/1 to 85 mm/s
         (In steps to 1 mm/s)

[HIGH TORQUE] mode selected: 3000 to 12000 RPM
[HIGH SPEED] mode selected : 5000 to 20000 RPM
                                                    (In steps of 100 RPM)
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 1 ENGLISH
>2 JAPANESE
             -<END>-

      MDX-500
   Roland DG Corp.

Hit "ENTER" >RML-1
Select MODE  NC-CODE

MODE   : RML-1
SPINDLE: HIGH TORQUE

*X      0  Y      0
 Z      0   5000 RPM

  3 MECHA MOVING
  4 ORIGIN CHANGE
  5 MOVING MODE
  6 COMMAND SET
  7 CONNECTION
  8 SERIAL PARAMETER
  9 COMPENSATE
 10 OTHERS
 11 SELF MODE
 12 To Coordinate
    -<RML/MODELING>-

 1>1 X/Y CUT SPEED
   2 Z DOWN SPEED

   3 X/Y MOVE SPEED
   4 Z UP SPEED
   5 To Main MENU
             -<END>-

 1-1 X/Y CUT SPEED
          <  2 mm/s>

 1-2 Z DOWN SPEED
          <  2 mm/s>

 1-3 X/Y MOVE SPEED
          < 85 mm/s>

 1-4 Z UP SPEED
          < 85 mm/s>

  2 SPINDLE RPM
         < 5000 RPM>

 3 >1 Go ORIGIN Pos.
    2 Go Z0 Pos.

    3 Go VIEW Pos.
    4 Go Z1 Pos.
    5 Go Z2 Pos.
    6 Go MAX Pos.
    7 Go USER Origin
    8 Go CENTER Pos.
    9 Go LIMIT Pos.
   10 To Main MENU
             -<END>-

POWER ON

X/Y CUT
SPEED

Z DOWN
SPEED

X/Y MOVE
SPEED

SPEED
SETTING

SPINDLE
RPM

MECHA
MOVING

Z UP
SPEED

[ENTER]

[ENTER][EXIT]

Next Page

[EXIT]

 >1 SPEED SETTING
  2 SPINDLE RPM

Main Menu

[EXIT] 0.5/1 to 85 mm/s
         (In steps of 1 mm/s)

0.5/1 to 85 mm/s
         (In steps of 1 mm/s)

0.5/1 to 85 mm/s
         (In steps of 1 mm/s)

0.5/1 to 85 mm/s
         (In steps of 1 mm/s)

[HIGH TORQUE] mode selected: 3000 to 12000 RPM
[HIGH SPEED] mode selected : 5000 to 20000 RPM     (In steps of 100 RPM)

Select "RML-1"

Switch on the power while 
holding down the [EXIT] key

[ENTER]

Select "ENGLISH"

MDX-500
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  4 ORIGIN  CHANGE
              <USER>

 5-1 SPINDLE CONTROL
                <ON>

 5-2 OVER AREA
          <CONTINUE>

 5-3 SMOOTHING
                <ON>

 5-4 ACCELERATION
              <0.3G>

 5>1 SPINDLE CONTROL
   2 OVER AREA

   3 SMOOTHING
   4 ACCELERATION
   5 To Main MENU
             -<END>-

SPINDLE CONTROL

OVER
AREA

SMOOTHING

ORIGIN
CHANGE

MOVING
MODE

ACCELERATION

 8>1 STOP BIT
   2 DATA BIT

   3 PARITY BIT
   4 BAUD RATE
   5 HAND SHAKE
   6 To Main MENU
             -<END>-

SERIAL PARAMETER

 7 CONNECTION
              <AUTO>

CONNECTION

 6 COMMAND SET
              <AUTO>

COMMAND
SET

Next Page

Previous Page

[EXIT]

 8-1 STOP BIT
                 <1>

 8-2 DATA BIT
                 <8>

 8-3 PARITY BIT
              <NONE>

 8-4 BAUD RATE
              <9600>

STOP
BIT

DATA
BIT

PARITY
BIT

BAUD
RATE

 8-5 HAND SHAKE
         <HARD-WIRE>

HAND
SHAKE

[EXIT]

USER/LIMIT/CENTER

ON/OFF/EXTERNAL ONLY

CONTINUE/PAUSE

ON/OFF

0.05G/0.1G/0.3G

MODE-1/MODE-2/AUTO

AUTO/SERIAL/PARALLEL

1/2

7/8

NONE/ODD/EVEN

4800/9600/19200/38400

HARD-WIRE/XON/XOFF
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10-1 SENSOR MODE
 Please Cursor Move

10-2 SPINDLE UNIT
       <HIGH TORQUE>

10-3 BUZZER
                <ON>

10-4 SENSOR HEIGHT
          <15000 um>

10>1 SENSOR MODE
   2 SPINDLE UNIT

   3 BUZZER
   4 SENSOR HEIGHT
   5 REVOLUTION TIME
   6 To Main MENU
             -<END>-

 9>1 X-COMPENSATE
   2 Y-COMPENSATE

   3 Z-COMPENSATE
   4 To Main MENU
             -<END>-

SENSOR
MODE

SPINDLE
UNIT

BUZZER

COMPENSATE

OTHERS

SENSOR
HEIGHT

10-5 REVOLUTION TIME
             0 Hour

REVOLUTION
TIME

 To Coordinate

Previous Page

[EXIT]

 9-1 X-COMPENSATE
          <100.00 %>

 9-2 Y-COMPENSATE
          <100.00 %>

 9-3 Z-COMPENSATE
          <100.00 %>

X-COMPEN-
SATE

Y-COMPEN-
SATE

Z-COMPEN-
SATE

[EXIT]

11-1 SURFACE CUT
Are You Sure?[ENTER]

11>1 SURFACE CUT
   2 To Main Menu

SURFACE
CUT

SELF
MODE

[EXIT]

*X      0  Y      0
 Z   1500   5000 RPM

99.90 to 100.10%
(In steps of 0.01%)

HIGH TORQUE/HIGH SPEED

ON/OFF

0 to 30000 um
(In steps of 10 um)

99.90 to 100.10%
(In steps of 0.01%)

99.90 to 100.10%
(In steps of 0.01%)
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PAUSE>CONTINUE
      STOP

      X/Y CUT SPEED
      Z DOWN SPEED
      X/Y MOVE SPEED
      Z UP SPEED
      SPINDLE RPM
             -<END>-

PAUSE:X/Y CUT SPEED
          <  2 mm/s>

PAUSE:Z DOWN SPEED
          <  2 mm/s>

PAUSE:SPINDLE RPM
         < 5000 RPM>

Press the [PAUSE] key

X/Y CUT
SPEED

CONTINUE

Z DOWN
SPEED

STOP

SPINDLE
RPM

PAUSE:Z UP SPEED
          < 85 mm/s>

Z UP
SPEED

PAUSE:X/Y MOVE SPEED
          < 85 mm/s>

X/Y MOVE
SPEED

[EXIT]

Stopping the cutting process

Cutting continues

0.5/1 to 85 mm/s
         (In steps to 1 mm/s)

0.5/1 to 85 mm/s
         (In steps to 1 mm/s)

0.5/1 to 85 mm/s
         (In steps to 1 mm/s)

0.5/1 to 85 mm/s
         (In steps to 1 mm/s)

[HIGH TORQUE] mode selected: 3000 to 12000 RPM
[HIGH SPEED] mode selected : 5000 to 20000 RPM
                                                    (In steps of 100 RPM)
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- MEMO -
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- MEMO -
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